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1. Hardware Checklist
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B) USB drive containing software (SQA100)

C) Getting Started manual (this booklet)

D) USB Cable (LC77)

E) Mounting bracket/stand for logger (WB6)

F) Batteries, 6 x AA

G) Current shunt resistors for 4 to 20mA inputs, 10R x 4 (CS202)

H) Connectors: 6 way x 4 (18097), 4 way (13975), 3 way
(14174), with cable ties

A) SQ2020/2040 Logger @

Note: 2040 Logger is supplied with 4 extra 6 way connectors
as above (18097).
Wi-fi version also contains an antenna.
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2. General Information

21 Installing the batteries
The 2020/2040 uses six AA size alkaline batteries located under the removable cover

shown below. To insert new or change the existing batteries:
1. Open the battery cover by pushing down and sliding as shown.
2. Insert six AA* batteries, ensuring the correct polarity.

3. Refit the battery cover

* It is recommended that all replacement batteries are of the same manufacturer, type
and condition.

Important: Remove the batteries when the logger is not used for long periods of
time or is being transported

2.2 Power indicator
Battery indicator
. When logging please ensure that the batteries in the unit have sufficient capacity to
complete the logging task. This can be checked via the battery indicator located in the
top right of the display.

HIGH LOW
CAPACITY CAPACITY

// External power indicator
The logger may be powered from an external source (10-18V DC)

Important: To ensure data protection in the case of an unexpected power loss,
please ensure that batteries are fitted whilst the unit is operational.

$Q2020/40

18108 Version 17

Page 3
www.grantinstruments.com



3. Communicating with your Logger

3.1 Installing the Software

For detailed installation instructions please see the supplied ‘Software Installation Guide’
supplement. For quick installation please see the steps below;

1. Ensure you have administration rights on the PC you wish to install software on

2. Ensure any current Grant applications are closed

3. Insert the USB drive into the USB port of your computer, open the USB drive
window and run the .exe program.

4. Follow the on screen installation wizard

Important: Please ensure the software is installed before connecting the Squirrel data
f j E logger.

3.2 Connecting your Squirrel Data Logger

You can connect to your logger by using one of the following methods;

1. Serial (RS232), including serial adaptors
2. USB

3. Ethernet (where fitted)

4. Wi-fi (where fitted)

Please see below for more information.

Serial (RS232)

For information on using serial adaptors please see the SquirrelView help file. If using a
straight serial (RS232) cable, connect one end to the serial port on the logger and the other
end to the PC’s serial port. Once connected you are ready to begin communications.

SQ2020/40 18108 Version 17
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usB
Connect one end of the supplied USB lead to the logger and the other end to the PC.

On detection of the logger the PC will install the Grant Instruments SQ20XX USB device
drivers

Win 7/Vista - USB Device Drivers are automatically installed and no further action is re-
quired

Win XP - During the installation the USB drivers were pre-installed so the wizard will
automatically locate the driver. On the ‘Found New Hardware Wizard’ select ‘No, not this
time’ and for all the other screens select ‘Next’ to complete the installation.

Found New Hardware Wizard Found New Hardware Wizard
Welcome to the Found New e
Hardware Wizard

‘Windows will search for current and updated software by
looking on your computer, on the hardware instaliation CD. of on
the Windows Update Web site (with your permission).

Read ow privacy policy

This wizard helps you install software for:

Grant Instruments 20xs USB Driver

() 1f your hardware came with an installation CD
&2 or floppy disk, insert it now.

What do you wand 2
2 nstall the software automaticall (Hecommended)
O il

Click Next to continue.

Can Windows connect to Windows Update to search for
software?

© Yes, this time only
Yo nd every time | connect a device

Click Next to continue.

Select Continue Anyway on the Hardware Installation warning which refers to Windows
Logo testing. Once the driver installation has completed you are ready to communicate to
your logger.

If you experience any problems refer to Troubleshooting->20xx USB Drivers in SquirrelView
Help.
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Ethernet

Before using the Ethernet connection please read the configuration manual which can be
found under ‘~\SquirrelView\Manuals\SQ20xx Inbuilt Ethernet Configuration.pdf’ where
‘~\SquirrelView’ is the installation directory of SquirrelView. Connect your Ethernet network
to the Ethernet port on the logger.

A Ethernet is only available when the logger is connected to an external power supply.
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Wi-fi
Before using the Wi-fi connection it is necessary to assemble the antenna to the logger as
shown below.

1. Screw the antenna onto the threaded socket and orient it in the same direction as
the antenna on the receiver connected to the PC (usually vertical).

2. Attach an external power supply to the logger.

3. Turning on the power will cause the yellow and green lights on the module to start
flashing. A connection has been established when the yellow light stays on
permanently.

To complete the installation please refer to the configuration manual which can be found
under ‘~\SquirrelView\Manuals\SQ20xx Inbuilt Ethernet Configuration.pdf where
‘~\SquirrelView’ is the installation directory of SquirrelView.

ij? Wi-fi is only available when the logger is connected to an external power supply.
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4. Quick Start Example

After installing SquirrelView an example setfile will be installed within the SquirrelView
installation directory. The example file will log the internal temperature of the logger.
In order to familiarise yourself with the logger the novice user may find this example
Setup useful.

4.1 Start SquirrelView and Select Logger Type
Click on the shortcut icon on your desktop to launch SquirrelView or select it from your
start menu. When the SquirrelView Assistant is loaded, ensure the correct logger type
and communication method is selected.

Logger type can be viewed from the SquirrelView assistant, if you need to make any
changes select Logger Selection from the toolbar or run the Communication Wizard.
(Note: the default communication method is USB and you will need to change this via
the Communication Wizard if you are using any of the other communication methods).

4.2 Synchronise Logger & PC
It is advisable to start by synchronising the Logger clock with the PC clock.

R
o From . ) © From the Logger Logger Control | _ Actions & Trigers Cort
SquirrelView Assistant Setup screen select o Dae) T
click on Logger the Logger Control Set Logger Time Manuoly
Setup. tab. Set Logger Time to PC Time
o Il Click on ‘Set Logger PCTime:  20/10/2003 15,30.08
Time to PC Time’, Logger Date Fomat:  [DD/MMAYY -
click OK on the Logger dentifcation
Logger Sekup confirmation screen. Loooer 0 .
(This test is used to identify the logger)
$Q2020/40 18108 Version 17
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4.3 Running Quick Start Demo

0O In the SquirrelView
Assistant click ‘Logger

SquirrelView Assistant

Grant

SquirrelView-Assistant-

DATA ACGUIBITION

Setup’ to enter the Logger Setup
screen. From here open the
demo setfile using File -> Open
and select the appropriate file for
your logger type.

SB—Squirrel- 20X Fogger

&| | 7,

Logger Contrel | Communication
wizard

squirrel  Analysis Tools

&

Download Data

Logger Selection

:éz

Analysis

Logger Type

2F8

Meter Mode

Msed: (Double Click To Open)

Setup File (=.5%)
Erowse. ...

Remove  Clear

® The Logger
Setup screen
is now visible,

EIB®

i Logger, Setup (Quick Start Demo 1E8) - For 18 Loggers
File Sguirrel Wiew Options Help

DS A WM E

from here you o
will be able to E Mok Set Mot Set C hiok Set
set up your £ ot 5ot Mot Set c hiok: Set
logging ?; Mok Set Mot St c ok Set
requirements. E Mok Set hot set c Hok Set
J ot set ot set D Not Set
Within the Mot Set Mot Sst o Mot Set
Actual s Mot Set D ok Ser
Channels tab  ||E EE e
scroll down the [(Gireference Junction: 50 t2150'C e Junction 1 Internal 9 Sample Interval: A (00:00:01) Logging Interval: (00:00:0L) Mode: Inter
Sensor Type High Wolkage 1 F ot Set
column to Ref. pich volto=2_ 7 otset <
Junction 1. | +[
This is the Logger Control | ActinsTriggers | Configuration T DigitalfState | Alarms ]
input you will Logger Date | Time Logger IdentFication Mermory Mods
be reading in Set Logger Time Manually | i tew Logaer MemoryMode  |Stopwhenful v

(This text is used to identify the logger)

this example.

Set Logger Time to PC Time

Btion

IW
B (S} |00:00:11 j“ I Continuous

PC Time: 24/10{2006 12:50:14 Delayed Start

© The Job
Description
can be used to
describe your
setup.

o
~

] =

I Enable
Sensor Power Timers

A(supply) |on:00:3 4 [ Continuous

@ Communication ‘

18108 Version 17
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O Click

to send
setup to
logger

at;

and start

logging. Let the unit

log for a few
minutes.

O In the Logger
Control window
you can view
various status
information.

To stop logging,
click on the stop
button.

O Click for @ Click @ Click on
Squirrel- if you Logger
View ﬂ wish to Control q
Assistant. meter to view
the input status of
in Real Time. logger
1 Loggen Control E|
Squirrel  Wiew
| & X BB 3
fAger Information Mermory
gﬁ'jLogger j(n] Logger ID ﬁbﬂlnternal Memary Total 15616 KB
2B Serial Number KS0617012 B8Internal Memary Used 14496 KB
yijnggar Type 2F8 ﬁbﬂlnternal Memary Free 1120 KB
gijoggar State Disarmed
Date and Time Pawer Supply
[aBLogger Time 23/10/2006 12:37:03 B8 nternal supply 00y
:"ﬁ]Status Last Updated Z23/10/2006 14:358:49 ﬁlﬂExternal Supply 1z.ov
[aBPC Time 23102006 14:35:49

© To Download the logger, click on
the ‘Download Data’ icon from the
SquirrelView Assistant.

&

Download Daka

$Q2020/40
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X

! Download
Squirrel  View

Logger Data Files

04120547 04135524 04145536 04150726 05095550 14153917

Lagaer Data File Information

Data file 04120547

JDb Description fillup

3] arm Time 04/07/2006 12:05:47
Disarm Tirne 04/07§2006 13:30:17

14153923 041359950 04140004 04140019 0S071157 5.07 MB
Down\oaded Yes
Action After Download |Exp0rt Data j Advanced | Download Selected File(s)

Mo Action

Expoart Data

@ In this screen you can now download the Data File and invoke the Export Wizard or
download the Data File to Analysis* (See Download Process Explained).

The data File is given a unique name
(e.g. 28162735.D20). An explanation of

the file name is shown on the right; this ZB'DZO
shows the date and start time TIME(24HR)

In this example you will download and view the Data in the Analysis* window. Start by
selecting the Data File and Graph Data action, then click Download Selected File(s).
You will be prompted to save the Data file, then the data will be converted for viewing.

® Once the decoding has wiaxme :
taken place the Analysis File SEe S — i
Description window will be Er A ! \ =
presented, click OK to view 35 = / / \\ =
your Data. e 5 - | o
= ol ‘/ -
ool ] ‘
Analysis File Description =6 =6
Enter a unique description for the new Analysis File e Redl T e
[Quick Start Demo| E R
o e
@
< > Summary Readnas Statistics. Jab ko Channl Info. .
*Available with SquirrelView Plus only.
18108 Version 17 SQ2020/40
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5. Download Process Explained

Logger

Data Files L
b

—

,’/
Data File

(.d20)

(.d20) Analysis

Analysis File
(Plus Only)

SquirrelView

Comma Separated Values

The Diagram above shows the download process. Data in the logger is written to the internal
memory and may be downloaded by SquirrelView.

Before the data can be viewed it must be converted by SquirrelView for Analysis or exported
to .csv or .xls format depending on the PC software being used.

The conversion process can be performed in one of three ways within SquirrelView:
— from SquirrelView assistant->Analysis->Export Data File
— automatically when using the download Data button from SquirrelView*

— or from the Logger Data Analysis screen by selecting File->Import Data menu*

Once the file has been downloaded it can be double clicked to open it with the program specified
under ‘Tools’, ‘Preferences’, ‘File Association Action’.

*Available with SquirrelView Plus only.

$Q2020/40
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6. Menu and Navigation

6.1 Control Panel
The illustration below shows the navigation controls in more detail.

RIGHT/DOWN
NAVIGATION

ENTER/CONFIRM &

e ¢ D

LEFT/UP
NAVIGATION

POWER ON
ESCAPE/BACK
(reverts to previous
Menu)

To use the 2020/2040 control panel

press €. P --Mainm Meru------- [ |

The display timeout is preset IEI Ln#'r 1 @ E‘

to 10 seconds, this can be changed in ‘I'f

the Configuration tab within the Logger

Setup window of SquirrelView. Log Comtrol

18108 Version 17 SQ2020/40
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6.2 Control panel menu
Detailed below is a basic explanation of the top menu structure. For more information on
the whole menu structure please refer to the Help->Help Content->Loggers within

SquirrelView.
6.2.1 Log Control --Main Mepu------- 2
In this menu you can Arm (activate), Pause IE LE
and Continue or Disarm (deactivate) the D

logger. Tf

Log Control

--Main Meru-------
6.2.2 Meter
Here you can view each channel in Real - P . @ D
Time (at 1-2Hz). Use the Enter key for a D Tf
graphical view of a channel.
Meter
--Haln Mehu-------
6.2.3 Status o b [i] BY 5:
The Status menu gives you access to
information relating to the logger such as Tf
available memory and power supply Status
voltage. You can also override the alarm
outputs from here.
--Ha1h Mehu-------
624 Setup v e i B D
This contains menus for setting up Tf
Language, Time & Date, basic Channel
Setup, storing and recalling setups and Setup
delayed starts.
See 6.3 for more details on basic setup
--Main Menu------- | |
L =
6.2.5 Data Files D ke i B H
This menu allows you to copy data files to Tf
an external memory card (if fitted) and Data Fil
delete the data files held within the ava Ties
logger's memory.
--Main Menu------- | |
6.2.6 Tools ol i B
The Tools menu contains maintenance (=]
type functions such as querying the
software version or IP address of the Tools
logger, performing a self test and resetting
the logger.
SQ2020/40 18108 Version 17
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6.3 Creating a basic Setup

The 2020/2040 allows for the creation of a basic channel setup including logging inter-
val, sensor type and sensor power (excitation) if required via the graphical interface, A
full setup including more advanced features can be performed using the SquirrelView
software included. Below is a brief explanation of how to create a basic channel using
the graphical interface

--Setup----------- | |
6.3.1  Channel Setup ?ﬁfgggaaﬁ'gwer
From the ‘Main Menu’ choose the option D |
‘Setup’ then the option ‘Channel Setup’. D;?Eﬁed-gggﬁ
Date/Time
Configuration
6.3.2 Adding or Editing a Channel —_Charnel Setup--- @
Once in ‘Channel Setup’ you can clear all Clear Channels
channels, add/edit a channel, view channel D iew Channe
details or delete a channel. Select ‘Add/Edit Delete Channel
Channel'.

6.3.3 Adding a New Channel

The ‘Add/Edit Channel’ menu shows channels ok .
currently set as well as giving you the option to
add others. Select ‘Add Channel D

6.3.4 Channel Setup c-Lhannel Setup--- @
Select the channel Sensor Type, Range and, anae )
if required, which Sensor Power (excitation) D |[Fensor Power Timer
time is to be used .

6.3.5 Viewing Channels Setup --Lliew Chfnnel ----
Once you have finished adding your required et Junction

channels and details the wiring configuration D
can be viewed using the ‘View Channels’
option.

(Y

Note that Channel Descriptions are

automatically assigned based upon the éégégﬁ EEQQEI ---- 1
Sensor Type of the channel. This description Mot Used
o . . S ; EBlock : A
can be modified using SquirrelView if required. T & 5 4 5 &
| e o]
18108 Version 17 SQ2020/40
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6.3.6 Interval Setup --Interuals------- []
A setup created from the control panel will T
assign all channels to the same logging
interval. To change or view this interval choose
‘Intervals’ from the main ‘Setup’ menu.
6.3.6 Sensor Power Setup --Sensor Timer A-- &

The sensor power setup can be changed by
going to ‘Sensor Power’ from within the main D [Gonrinuous
‘Setup’ menu. Wiring

A Important Notes on Setup using the Control Panel

Full setup capabilities of the 2020/2040 are provided using the SquirrelView software
provide. When using the control panel a few important points should noted:-

. Whilst all channels are assigned to the same interval, Interval A, all intervals can be
viewed in the case of a more complex setup from SquirrelView

° To avoid problems with wiring configuration, sensor types are not editable once set but
their range and sensor power requirements can be. Delete a channel if you require to
change its Sensor Type

. If the number of sensors is exceeded when adding new channels, the message "Invalid
Setup" will be displayed

° Calculated channels setup from SquirrelView will not be shown on the view channels
option
. The reference junction can not be deleted while a sensor type that requires it for

correct operation is set up, e.g. a thermocouple
° You cannot change a setup whilst the logger is armed

U The message "Sub-Second rate" will be displayed when attempting to view or edit a
Sample Intervals that have been set to less than 1 second. Use Squirrelview Logger
Setup to view or edit the sub-second Intervals

SQ2020/40 18108 Version 17
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7. Connections

Analogue Inputs

ﬁBLOCKH BLgCK\ [BLOCKH
£

12A45m 12C45m 1E3 Rear view of
12B45m 12D45m 12F4 ANALOGUE
connectors

BLOCK |_ BLOCK | BLOCK
B D F

BLOCK BLOCK
G J

12G45m 12J 4 5m Rear view of
1 2HA45m 12K4 5 ANALOGUE
connectors

BLOCK BLOCK
H K

NOTE: Blocks G to K as shown above are
only available on 2040 loggers.

As the wiring configuration is dependant upon the sensor type used, it is displayed in SquirrelView
during the setup. Follow the wiring diagram to attach the required sensor. If you would like to print
the diagrams in more detail or view at a later stage select ‘File > Print from Logger Setup’.

The example below shows the actual K type differential thermocouple sensor connected to the 2020

logger from the wiring diagram to the left.

= Range Selection 3]
Add/Edit Scaling

Ranges available
-200 to 1372 °C
-328 to 2501 °F

Voltage - Dif jal
Voltage - Single ended
Current

D Thermocouple - Differential

5 Thermocouple - Single ended A
C Thermacouple - Single ended
D Thermacouple - Single ended
) Thermocouple - Differential
KTh

[N Thermacauple - Differential
R Thermocouple - Differential

"'
S Thermocouple - Differential

The Reference Junction is required for logging of Thermocouples and will be set automatically

=1

UnSet chamnel | Cancel

18108 Version 17
Page 17
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Sensor Power Wiring High Voltage Input

0

]
e
Unregulated Logger .
gSuppIy OL?t?)ut Negative V1(+ve) V2(-ve)
olo e B b
Regulated 5V Output — V1(-ve) — T V2(+ve)
( Y ! N
- “ J
1/0 Socket Wiring
Pin Connection
PIN 1 1 Event/State Input 1
2 Event/State Input 2
3 Event/State Input 3
4 Event/State Input 4
5 Event/State Input 5
6 Event/State Input 6
7 Event/State Input 7
8 Event/State Input 8
|1 ] | 9 Ground
10 Alarm Output A
1 Alarm Output B
12 Alarm Output C
13 Alarm Output D
14 Auxiliary Output +ve
15 Auxiliary Output +ve
16 Auxiliary Output -ve
17 Auxiliary Output -ve
18 Ground
19 Ground
20 Ground
21 Fast Pulse Input 1
22 Fast Pulse Input 2
SLOW PULSEl |FAST PULSEl 23 Slow Pulse Input 1
I/P 1-2 |/P 1-2 24 Slow Pulse Input 2
25 No Connection

External Memory Card Reader

The external SD card slot is located inside the battery
compartment.

SQ2020/40 18108 Version 17
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8. Accessories

Grant Instruments supply a wide range of accessories to compliment the range of Squirrel data
loggers. These include adapters as shown below which allow you to contact your Squirrel data
logger remotely. All are very easy to install and connect directly to the logger via RS232. If you
need any further details or wish to make a purchase please contact Grant or your local supplier for

more details.

GSM

Wireless

RS232 to Ethernet Converter consisting of adaptor box and modem setup Part No:
Cable. Ethernet configuration software is suitable for Windows 2000 and XP only. SQ20A801
GSM Modem kit comprising of modem, Squirrel connection cable, power lead

and antenna with 3m lead. A data-enabled SIM card will also be required

from your network service provider. SQ20A802
Wireless Adaptor comprising of an RS232 adaptor for connecting the logger to the

PC at baud rates up to 115K2 with a range of up to 200 metres using the 2.4GHz

frequency band. The kit is supplied with all connecting leads.

Note: power supplies (MPU 12V) to be ordered separately SQ20A803
18108 Version 17 SQ2020/40
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Removable external memory option
SD Memory Card.

Software packages for set-up, transfer and data analysis:

SquirrelView Plus

Provides full data analysis, on-line graphing, meter to Excel and export to Excel
SquirrelView Plus Multi-User License

Unlimited use of SquirrelView within a single organisation.

Calibration Certificates for Squirrel 2020/40 series (all ranges)

Note: Test and Calibration Certificates from Grant Instruments are traceable to
National Standards

SQ2020

SQ2040

Weatherproof box
Robust plastic weatherproof box

Wall bracket
Stainless steel wall and desk bracket

Power supplies

100-240V AC 50/60Hz supplied with 3-single fit mains plugs for UK, Euro, and US
As MPU 12V but supplied with 1m flying lead

Rechargeable battery (12V, 6Ah)

Rechargeable battery (12V, 15Ah)

Digital I/O interface connector

25 way D connector type sub miniature solder connection with cover for digital
inputs, alarm and pulse inputs

Current Shunts
Pack of 4 precision resistors for 4-20mA analogue channels

Cables for connecting data loggers to computers/modems.
Squirrel to PC serial port

Squirrel to PC USB port

Squirrel to modem

12V DC power lead
2.1mm DC connector and fused with 1.8m lead

Terminal Blocks

Plug-in terminal blocks with cable restraint
3-way

4-way

6-way

Temperature and Humidity probes

Part No:

MMC64

SQA200
SQA300

CAL2020

CAL2040

PEL4

WB6

MPU 12V
MPU 12VFL
SQ20RB12-6
SQ20RB12-15

SB102

CS202

LC71
LC77
LC73

LC76

14174
13975
18097

Grant offers a range of temperature and humidity probes suitable for use with its data loggers and
other compatible measurement systems. Bespoke or specialist probes are also available. Please

enquire if you have specialist probe needs.

$Q2020/40
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9. Specifications

ANALOGUE INPUTS

Basic accuracy (5-45°C): ........ccoooviiiiiniiiee + (0.05% readings + 0.025% range)
Common MOde FEJECHION: ..........coiiiiiiiiiiie et 100dB
Input impedance: ................. ..> 1MOHM
LIN@ATILY: .....ooiiiii e 0.0015%
Series mode line rejection:..............ccooiiiiiiiiii e 50/60Hz 100dB
EM field and Conducted RF effect: ..., <1% ¥
DIGITAL INPUTS
Zero input voltage. ............c.ooouiiiiiiiii e 0 to 0.5V (or shorted input)
One input voltage.............cccociiiiiiiiiii e 2.7 to 5V (or open circuit input)
Input protection..................coceiiiene. will turn on below about -0.5V and above about 6V
ANALOGUE-DIGITAL CONVERSION
LN L= TSP UPUSPRPP Sigma-Delta
RESOIULION: ... ettt e 24bit
Sampling rate: ... Up to 20/100 readings per second
Note: 100Hz Mode not available on 1F8 models
ALARM OUTPUTS ..o 4 x open drain FET (18V 0.1A Max)
SENSOR POWER SUPPLY .........ccccooovevrnrennnns Regulated 5 VDC (50mA) or supply voltage (100mA)
TIME AND DATE........coooiiiii e In built clock in 3 formats
SCALING DATA. ...t Displays readings in preferred engineering units
MEMORY
Internal: ... 128 Mb (Up to 14,400,000 readings)
External: ... Up to 1Gb removable MMC/SD memory card
RESOLUTION.......iiiiii ettt Up to 6 significant digits
PROGRAMMING/LOGGER SET-UP..........ccccceoovvveinnne SquirrelView or SquirrelView Plus software
COMMUNICATION. ..o USB 1.1 and 2.0 / RS232 / Ethernet (not 1F8)
Internal option: ... ettt e et a e aa Wi-fi
External options: ............cccooi i GSM, Ethernet and wireless
POWER SUPPLY
Internal: ... 6*x AA Alkaline batteries
External: ..., 10-18VDC, reverse polarity and over-voltage protected

T This effect may be larger at 288kHz, re-orientate the input cables or add a suitable
axial ferrite bead close to the logger input if required.

A * Maximum operating temperature for supplied alkaline batteries is 50°C

18108 Version 17 SQ2020/40
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POWER CONSUMPTION @ 9V

SIEEP MOUE: ...t e ae e raea s <600pA
LOGGING: .ot 40 - 120mA
DIMENSIONS AND WEIGHT

2020 Logger
DIMENSIONS: ... W235 x D175 x H55 mm

Enclosure Material: ...............oooiiiiiiiiiiie e ABS

2040 Logger

DIMENSIONS: ... W235 x D175 x H92 mm
Weight: ................

Enclosure materia

MEMORY MODES (internal only)..............cccccooiiiiiiiiiiiieie e Stop when full or overwrite
DISPLAY AND KEYPAD

2 line x 20 character LCD
OPERATING ENVIRONMENT .......oouiiiiiiiiieie ettt e en -30°C to +65°C

Windows is a registered trademark of Microsoft
Corporation in the United States and other countries.

Due to our policy of continuous improvements, specifications may change
without prior notice.

Grant believe that all information declared is correct at the time of issue.
No liability is accepted for errors and omissions.
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1. Liste de contrbéle du matériel

c
Grant

e

ol Data LO9Y
squirre! SERES
20020005y

) a A A L U o s
TR

A) Enregistreur SQ2020/2040
B) Clé USB contenant des logiciels (SQA100)
C) Manuel d’initiation (la présente brochure)

D) Cable USB (LC77)
E) Support de montage/socle pour I'enregistreur (WB6)
F) Piles, 6 x AA

G) Reésistances de dérivation de courant pour entrées de 4 a
20 mA, 10R x 4 (CS202)

H) Connecteurs : 6 voies x 4 (18097), 4 voies (13975),
3 voies (14174), avec attaches de cable

Remarque : L’enregistreur 2040 est fourni avec 4 connecteurs
6 voies supplémentaires comme ci-dessus (18097).
La version Wi-fi comporte également une antenne.
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2. Généralités

21 Installation des piles

Le 2020/2040 utilise six piles AA situées sous le couvercle amovible illustré ci-
dessous. Pour insérer des piles neuves ou remplacer des piles usagées :
1. Ouvrez le couvercle des piles en le poussant vers le bas et en le faisant
coulisser comme illustré.
2. Insérez six piles AA*, en vérifiant que la polarité est correcte.
3. Replacez le couvercle des piles

* |l est conseillé d'utiliser des piles de rechange de méme marque, type et état.

——

Important : Retirez les batteries de I'enregistreur lorsqu'il n'est pas utilisé pendant
un certain temps ou lors de son transport.

2.2 Indicateur d’alimentation

Indicateur de batterie

I Lors de la connexion, vérifiez que la capacité des piles de I'appareil est suffisante pour
terminer la tache d’enregistrement. Vous pouvez le vérifier grace a l'indicateur de
batterie situé en haut et a droite de I'affichage.

HAUTE FABLE
CAPACITE CAPACITE

Indicateur d’alimentation externe
// L’enregistreur peut étre alimenté par une source externe (10 a 18 V CC)

Important : Pour garantir la protection des données en cas de coupure
d’alimentation imprévue, vérifiez que les piles sont installées pendant que
I’appareil fonctionne.
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3. Communiquer avec votre enregistreur

3.1 Installation du logiciel

Pour des instructions d’installation détaillées, consultez le supplément ‘Guide d’installation
du logiciel’ fourni. Procédez selon les étapes ci-dessous pour une installation rapide ;

1. Vérifiez que vous disposez des droits d’administration pour le PC sur lequel vous
souhaitez installer le logiciel

2. Vérifiez que toutes les applications Grant sont fermées

3. Insérez le clé USB dans le port USB de votre ordinateur, ouvrez la fenétre du
lecteur USB et lancez le programme .exe.

4. Suivez les instructions de I'assistant d’installation

Important : Vérifiez que le logiciel est installé avant de connecter I’enregistreur de
données Squirrel.

3.2 Raccordement de I’enregistreur de données Squirrel

Vous pouvez vous connecter a votre enregistreur a I'aide de I'une des méthodes suivantes ;

1. Série (RS232), y compris adaptateurs série
2. USB

3. Ethernet (si installé)

4. Wi-fi (si installé)

Consultez les informations complémentaires ci-dessous.

Série (RS232)

Consultez le fichier d’aide de SquirrelView pour des informations sur I'utilisation des adapta-
teurs série. Si vous utilisez un cable série direct (RS232), raccordez une extrémité au port
série de I'enregistreur et I'autre au port série du PC. Une fois la connexion établie, vous
pouvez commencer a communiquer.
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usB
Raccordez une extrémité du cable USB fourni a I'enregistreur et I'autre au PC.

Lors de la détection de I'enregistreur, le PC installe les pilotes de I'appareil USB.

Win 7/Vista - Les pilotes de I'appareil USB sont installés automatiquement ; aucune autre
action n'est requise.

Win XP - Les pilotes USB ont été préinstallés lors de I'installation, afin que I'assistant locali-
se automatiquement le pilote. Dans ‘Found New Hardware Wizard’ (Nouvel assistant maté-
riel détecté) choisissez ‘No, not this time’ (Non, pas cette fois), puis ‘Next’ (Suivant) dans
tous les autres écrans pour terminer I'installation.

Found New Hardware Wizard Found New Hardware Wizard
Welcome to the Found New e
Hardware Wizard

‘Windows will search for current and updated software by
looking on your computer, on the hardware instaliation CD. of on
the Windows Update Web site (with your permission).

Read ow privacy policy

This wizard helps you install software for:

Grant Instruments 20x USB Driver

() 1f your hardware came with an installation CD
&2 or floppy disk, insert it now.

What do you wani 2
) install the scftware automalicaly [Recommended)
O el

Click Next to continue.

Can Windows connect to Windows Update to search for
software?

. this time only
every time | connect a device

Click Next to continue.

Sélectionnez Continue Anyway (Continuer quand méme) lors de I'avertissement
d’installation matérielle se rapportant au test du logo Windows. Une fois l'installation du
pilote terminée, vous pouvez communiquer avec I'enregistreur.

Si vous rencontrez des difficultés, consultez la rubrique Dépannage->pilotes USB 20xx
dans l'aide de SquirrelView.
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Ethernet
Avant d'utiliser la connexion Ethernet, lisez le manuel de configuration qui se trouve dans le

fichier ‘~\SquirrelView\Manuals\SQ20xx Inbuilt Ethernet Configuration.pdf ou
‘~\SquirrelView’ est le répertoire d’installation de SquirrelView. Connectez votre réseau

Ethernet au port Ethernet de I'enregistreur.

10-18V DC

-t

Ethernet n’est disponible que lorsque I’enregistreur est raccordé a une alimentation
électrique externe.
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Wi-fi
Avant d'utiliser la connexion Wi-fi, il est indispensable d’assembler I'antenne sur
I'enregistreur comme illustré ci-dessous.

1. Vissez I'antenne dans ['orifice fileté et orientez-la dans la méme direction que
I'antenne du récepteur connecté au PC (généralement a la verticale).

2. Raccordez une alimentation électrique externe a I'enregistreur.

3. La mise sous tension a pour effet de faire clignoter les voyants jaune et vert du
module. Une connexion est établie lorsque le voyant vert reste fixe en
permanence.

Pour terminer l'installation, lisez le manuel de configuration qui se trouve dans le fichier
‘~\SquirrelView\Manuals\SQ20xx Inbuilt Ethernet Configuration.pdf’ ou ‘~\SquirrelView’ est
le répertoire d’'installation de SquirrelView.

La Wi-fi n’est disponible que lorsque I'enregistreur est raccordé a une alimentation
électrique externe.
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4. Exemple de mise en route rapide

Une fois SquirrelView installé, un exemple de fichier de configuration est installé dans
le répertoire d’installation de SquirrelView. Le fichier d’exemple enregistre la

température interne de I'enregistreur.
L’utilisateur novice peut trouver cet exemple de configuration utile pour se familiariser

avec I'enregistreur.

4.1 Démarrez SquirrelView et sélectionnez le type d’enregistreur
Cliquez sur I'icéne de raccourci de votre bureau pour démarrer SquirrelView ou
sélectionnez-le dans votre menu de démarrage. Une fois I'assistant SquirrelView
chargé, vérifiez que le type d’enregistreur et la méthode de communication corrects

sont sélectionnés.

Le type d’enregistreur est indiqué dans I'assistant SquirrelView ; pour effectuer des
modifications, sélectionnez Logger Selection (choix de I'enregistreur) dans la barre
d’outils ou exécutez I'assistant de communication. (Remarque : la méthode de
communication par défaut est en USB. Elle doit étre changée via I'assistant de
communication si vous utilisez d’autres méthodes de communication).

4.2 Synchronisez I'enregistreur et le PC
Il est conseillé de commencer par synchroniser I'horloge de I'enregistreur avec celle du

PC.

® Cliquez sur

Logger Setup
(Configuration

de 'enregis-

treur) dans =

I'assistant
SquirrelView.
Logger Setup

® Dans I'écran Log-  —==

Logger Control I Actions & Triggers Conf
ger Setup . Logger Date / Time:
(Configuration de Set Logger Time Manualy
I'enregistreur), sélec- Set Logger Time o PC Time
tionnez I’onglet LOg- PC Time: 20/10/2003 15:30:08
ger Control Lagger Date Format:  [DD/MMAYY >

(Commandes de I'en- Logger Identiication

registreur). Cliquez Em

(This text is used to identify the logger)

sur ‘Set Logger Time
to PC Time’ (Régler

I'heure de I'enregistreur sur celle du PC), cliquez

sur OK dans I'écran de confirmation.

$Q2020/40
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4.3 Exécution de la démonstration de mise en route rapide

W SquirrelView Assistant

Grant

© Dans l'assistant SquirrelView
cliquez sur ‘Logger

Setup’ (Configuration de I'enre-
gistreur) pour accéder a I'écran
du méme nom. Ouvrez ensuite le
fichier de démonstration de confi-
guration avec File -> Open

DATA LOGGING

Tools Help

=

Meter Mode

Squirrel  Analysis Logger Selection

Logger Setup

Download Data

1

Analysis

Logger Control - Communication

SquirrelView

Logger Type

2010

[;zﬂ

Wizard

1

Previous FilesWsed: (Double Click To Open)
Setup File (*,5%)

(Fichier->Ouvrir) et choisissez
le fichier correspondant au type

EEroaram Fles s qurrehem st e Uik start demo 178520

de votre enregistreur.

ci\program Fies|squirrelview|setfilesiquick start demo 2F3.520

Remove  Clear

®| 'écran Logger
Setup

= Logger Setup (Quick Start Demo 1F€) - For 1F8 Logaers

CBX

(Configuration de File 'Sjusl .Vlew ODtmnsq}:E\% —
lenregistreur), HOES) e 8l
dans lequel vous ||, SR
pouvez définir B ([ set Mot Set c Mok Set
VOS beSOinS g Mot Set Mot Set C Mok Set
d’enreglstrement, g Mot Set Mot Set = Mot Set
eSt afﬁché - |[Met St Mot Set C Mok Set
J Mot Set Mot Set o} Mok Set
Dans l'onglet ot set ot St o hak Set
Actual Channels || st et o ot Set
(Canaux ac- § Mt Set o It Set ———
tuels), faites Ref. Junction 1 Internal 9 Sample Inkerval: A (00:00:01) Logging Inkerval: (00:00:01) Mode: Inter
A High Woltage 1 F Hok Set )
défiler la colonne gh vokag
Sensor Type High ¥oltage 2 F Mot Set -
Type de cap- [
Eelr",:; jusqu’épRef. Logger Control T Actions & Trigasrs T Configuration T DigitaliState T Alarms. ]
Junction 1 Logger Date [ Time Looger Identification Memory Mode
Il s‘agit de l'en- Set Logger Time Manually | My New Logger Memory Mode |Stop when ful -
= (This text is used ta identify the logger)
trée que vous St Logger Tieto P Tine — e e =]
Ilrez dalns cet PC Time 24/10/2006 12:50:14 m Delayed Start
S [~ Enable ;
) Sensor Power Timers
JetanonCt]On & (supply) [o0:001T0 =] [~ Contiuous 8(5%) o000 1 =] [ Continuous [esitorenoe fiessoios =1
ob Description
(Descriptioﬁ dela © Communication |
tache) peut servir
a décrire votre
configuration.

18108 Version 17
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@ Cliquez O Cliquez O Cliquez @ Cliquez

pour en- pour I'as- pour me- sur Logger

voyer la @ sistant @ surer Control q
configura- | # Squirrel- I'entrée en (Comman-

tion a View. temps des de
I'enregistreur et réel. I'enregistreur) pour
commencer |'enre- afficher I'état de
gistrement. Laissez I'enregistreur

I'appareil enregistrer
pendant quelques

minutes.
O Les différentes i Loggen Control X
informations d’é- Squirrel Wiew
tat sont afﬁghees ; b | & X =] 2
dans la fenétre
Logger Control ger Infarmation Mermory
(Commandes de gﬁ'jLogger ] Logger ID %ﬂlnternal Memory Total 15616 KB
Fenregistreur) BSerial Humber KsOB17012 Bfjinternal Memory Used 14496 KB
. yijnggar Type ZF8 ﬁbﬂlnternal Memary Free 1120 KB
gijoggar State Disarmed
Cliquez sur le
bouton d’'arrét
pour interrompre
I'enregistrement. ]
Date and Time Pawer Supply
[aBLogger Time 23/10/2006 12:37:03 B8 nternal supply 00y
:"ﬁ]Status Last Updated Z23/10/2006 14:358:49 ﬁlﬂExternal Supply 1z.ov
[aBPC Time 23(10/2006 14:36:49
© Pour télécharger I'enregistreur,
cliquez sur l'icéne ‘Download
Data’ (télécharger les données)
depuis I'assistant SquirrelView. Download Daka
SQ2020/40 18108 Version 17
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! Download
Squirrel  View

L Data Fil
0gger Data Hles Lagaer Data File Information

04120547 04135524 04145536 04150726 05095550 14153917

Data file 04120547

JDb Description fillup

3] arm Time 0407/2006 12:05:47
Disarm Tirne 04/07§2006 13:30:17
ab]File size 8.07 MB
Down\oaded Yes

14153923 04135950 04140004 04140019 05071157

action After Download |Exp0rt Data j Advanced | Dowinload Selected File(s)

Mo Ackion
Expart Data
® Dans cet écran, vous pouvez maintenant télécharger le fichier de données et appeler

I'assistant d’exportation ou télécharger le fichier de données via la fonction Analysis*
(Analyse) (Voir I'explication du processus de téléchargement).

Un nom unique est attribué au fichier de données
(par exemple 28162735.D20). Une explication du 28162735/.D20
( )

nom de fichier est fournie sur la droite ; elle indi- i
que la date et 'heure de début [TIME(24HR)|

Dans cet exemple, vous téléchargez et affichez les données de la fenétre Analysis*®
(Analyse). Commencez par sélectionner le fichier de données et I'action de données
graphiques, et cliquez sur Download Selected File(s) (Télécharger le(s) fichier(s)
sélectionné(s)). Vous étes invité a enregistrer le fichier de données, avant que les
données soient converties pour I'affichage.

B yow Gach ook b

@ Une fois le décodage effectud, la smuazme
PN . . PT) Tl Quick Start Demo R
fenétre Analysis File Description s m—
(Description du fichier d’analyse) A [ ! ‘ -
s’ouvre ; cliquez sur OK pour afficher 35 @ f ] | =
vos données. 3 N ! Vi f e
S Bl / -
saine o } - S
Analysis File Description =oilme. = = —tas
Enter a unique description for the new Analysis File m— e
[Quick Start Demo|
(o] oo
< > Sy | Waidad | s T Crvaiiio
*Disponible uniquement avec SquirrelView Plus.
18108 Version 17 SQ2020/40
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5. Explication du processus de telechargement

Enregistreur

Fichiers de L
données
—— (.d20) Analyse
(.d20) o
Fichier d’analyse
(Plus seulement)
/ Fichier _
: :eiosnl,l-r Lecteur :
carte > o : Exportation
MMC/SD
externe ' SquirrelView

Valeurs séparées par
des virgules

Le diagramme ci-dessus indique le processus de téléchargement. Les données de I'enregistreur
sont écrites dans la mémoire interne, et peuvent étre téléchargées par SquirrelView.

Pour pouvoir afficher les données, elles doivent étre converties par SquirrelView pour analyse ou
exportées au format .csv ou .xls, en fonction du logiciel PC utilisé.

Le processus de conversion peut étre effectué selon trois méthodes dans SquirrelView :

— depuis l'assistant SquirrelView ->Analysis->Export Data File
(SquirrelView ->Analyse->Exporter le fichier de données)

— automatiquement en utilisant le bouton de téléchargement des données dans SquirrelView*

— ou depuis I'écran Logger Data Analysis (Analyse des données de I'enregistreur) en choisis-
sant le menu File->Import Data (Fichier->Importer des données)*

Une fois le fichier téléchargé, il peut étre ouvert avec le programme spécifié dans ‘Tools’ (Outils),

‘Preferences’ (Préférences), ‘File Association Action’ (Action d’association de fichier) en cliquant
deux fois dessus.

*Disponible uniquement avec SquirrelView Plus.

SQ2020/40 18108 Version 17
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6. Menu et navigation

6.1 Panneau de commande
Lillustration ci-dessous présente les commandes de navigation plus en détail.

NAVIGATION
DROITE/BAS

ENTREE/
CONFIRMATION ET
MISE EN MARCHE

ECHAP/RETOUR
(revient au
menu précédent)

e ¢ D

NAVIGATION
GAUCHE/UP

Pour utiliser le panneau de commande du --Hain Mer------- ]

2020/2040, appuyezsurlatoucheO. IE' 1;'}.'-: -
i e

La temporisation de I'affichage est

préréglée sur 10 secondes, et peut étre Tf
modifiée dans I'onglet Configuration de la
fenétre Logger Setup (Configuration de Log Contral

I'enregistreur) de SquirrelView.

18108 Version 17 SQ2020/40
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6.2 Menu du panneau de commande
L’explication de base de la structure du menu principal est détaillée ci-aprés. Pour des
informations plus détaillées sur la structure de menu compléte, consultez Help->Help
Content->Loggers (Aide -> Contenu de I'aide -> Enregistreurs dans SquirrelView.

--Main Meruw------- | |
6.2.1 Log Control (Commande d’enregistrement) IE L’.E
Ce menu permet d’armer (activer) ou D
désarmer (désactiver) I'enregistreur. Tf
Log Control
6.2.2 Meter (Compteur) __Maim Mefu-------
Permet d’afficher chaque canal en temps
réel (a 1 a 2 Hz). Utilisez la touche entrée T . B D
pour obtenir I'affichage graphique d’un Tf
canal
Meter
6.2.3 Status (Etat) )
Le menu Status (Etat) permet d’accéder
aux informations relatives a I'enregistreur - '”‘3”" Menu-------
menu, notamment la mémoire et la tension a v . @ D
d’alimentation. Vous pouvez également y D
annuler les sorties d’alarme. Tf
Status
6.2.4 Setup (Configuration)
.Contient les menus de réglage de_la langue, - -Ham Mo -
de I'heure, de la date, la configuration de canal
de base, les réglages de stockage et de rappel iﬂ‘.{ . D
des configurations et le démarrage différé. D Tf
Des informations plus détaillées sur la Setup
configuration de base sont présentées dans
la section 6.3
6.2.5 Data Files (Fichiers de données) --Main flenu----- - '
2. ata Files (Fichiers de données ' .
Ce menu permet de copier les fichiers de " 11“-—-'5 1 E IE‘
données sur une carte mémoire externe (s'il D Tf
y a lieu) et de supprimer les fichiers de
données contenus dans la mémoire de Data Files
I'enregistreur.
6.2.6 Tools (Ouitils) --Maim Menu------- [
Le menu Tools (Outils) contient des e =
fonctions de maintenance D ! LE 1 @. E
telles que la requéte de la version du
logiciel ou I'adresse IP de I'enregistreur, Tool
I'exécution d’un autotest et la réinitialisation ool
de I'enregistreur.
SQ2020/40 18108 Version 17
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6.3 Création d’une configuration de base

Le 2020/2040 permet la création d’'une configuration de canal de base comprenant
l'intervalle d’enregistrement, le type de capteur et I'alimentation du capteur (excitation)
si nécessaire via l'interface graphique ; une configuration compléte comprenant des
fonctions plus avancées peut étre effectuée a I'aide du logiciel SquirrelView fourni. Une
breve explication de la méthode de création d’'un canal de base en utilisant I'interface

graphique est présentée ci-dessous

- -GEtup- - - [ ]
6.3.1 Configuration de canal ?ﬁ@g?ﬁﬁg“er
Depuis le ‘Main Menu’ (Menu principal), choi- ]
sissez I'option ‘Setup’ (Configuration) puis tored oetups
: . . D=l od-Start
I'option ‘Channel Setup’ (Configuration de nitéﬁime ‘__'P
canal). Configuration
6.3.2 Ajout ou modification d’'un canal _ _Charnel Setup--- @
Dans ‘Channel Setup’ (Configuration de canal), Clear Channels
vous pouvez effacer tous les canaux, ajouter/ 12w Channe
modifier un canal, afficher les détails d’un ca- Delete Channel
nal ou supprimer un canal. Sélectionnez ‘Add/
Edit Channel’ (Ajouter/modifier un canal).
6.3.3 Ajout d’'un nouveau canal -
Le menu ‘Add/Edit Channel’ ‘Ajouter/modifier e N .
un canal) affiche les canaux actuellement
configurés et vous permet d’en ajouter d’au-
tres. Sélectionnez ‘Add Channel’ (Ajouter un
canal)
6.3.4 Configuration de canal --Chatnel Setup--- @
Choisissez le type de capteur et la plage du EREE .
canal et, au besoin, la durée d’alimentation du Sensor Powsr Timer
capteur (excitation) devant étre utilisée.
6.3.5 Affichage de la configuration de canaux -Hisw Cha.:mnel ----
Une fois les canaux nécessaires et les détails 2T Junctioh
ajoutés, la configuration de cablage peut étre
affichée avec I'option ‘View Channels’ (Afficher
les canaux).
Notez que les descriptions de canal sont auto- 05 T 1 .
matiquement attribuées, en fonction du type de Coneon poonnet---- 1
capteur du canal. Cette description est modifia- éf‘{ﬂt kL!%E'd
ble avec SquirrelView s'il y a lieu. e e
o i |
18108 Version 17 SQ2020/40
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6.3.6 Réglage de l'intervalle --Intervals------- []
Une configuration créée depuis le panneau de
commandes attribue le méme intervalle d’enre-
gistrement a tous les canaux. Pour maodifier ou
afficher cet intervalle, choisissez
‘Intervals’ (Intervalles) dans le menu
‘Setup’ (Configuration).

12w

6.3.6 Configuration de I'alimentation du capteur --Sensor Timer A-- W
La configuration de I'alimentation du capteur
peut étre modifiée en accédant a 'option D [Gontinuous
‘Sensor Power’ (Alimentation du capteur) dans Wiring
le menu ‘Setup’ (Configuration).

A Remarques importantes sur la configuration a I’aide du panneau de commandes

Les capacités de configuration complétes du modele SQ2020/2040 sont fournies par le
logiciel SquirrelView. Lorsque vous utilisez le panneau de commandes, quelques as-
pects importants doivent étre notés :-

. Bien que le méme intervalle (intervalle A) soit affecté a tous les canaux, tous les inter-
valles peuvent étre affichés dans SquirrelView dans le cas d’une configuration plus
complexe

. Pour éviter les problémes de cablage de configuration, les types de capteur ne sont

pas maodifiables une fois déterminés, contrairement a leur plage et alimentation néces-
saire. Supprimez un canal si vous devez changer son type de capteur

. Si le nombre de capteurs est dépassé lorsque vous ajoutez de nouveaux canaux, le
message « Mauvaise config. » s'affiche

. Les configurations de canaux calculés dans SquirrelView ne sont pas affichées par
I'option d’affichage des canaux

° Il est impossible de supprimer une jonction de référence lorsqu’un type de capteur qui
I'utilise pour fonctionner correctement est configuré, par exemple un thermocouple A.

° Vous ne pouvez pas modifier une configuration lorsque I'enregistreur est armé

(] Le message « Vitesse < seconde » apparait lorsque vous tentez d'afficher ou de modi-
fier des intervalles d'échantillonnage qui ont été définis sur moins d'1 seconde. Utilisez
Squirrelview Logger Setup pour afficher ou modifier les intervalles

SQ2020/40 18108 Version 17
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7. Connexions

Entrées analogiques

BLOC BLOC BLOC
A c E
| |

12A45m 12C45m 1E3

Vue arriére
des
connec-
teurs
ANALOGI-
QUES

12B45m 12D45m 12FA4

= sy b

BLOC BLOC
G J

Vue arriere des
connecteurs
ANALOGIQUES

12G45m 12J 4 5m

12 H45m 12 K4 5m

BLOC BLOC
H K

REMARQUE : Les blocs G a Kiillustrés ci-

dessus ne sont disponibles
que sur les enregistreurs 2040.

La configuration de cablage dépendant du type de capteur utilisé, elle est affichée dans SquirrelView
lors de la configuration. Consultez le schéma de cablage pour raccorder le capteur correct. Pour
imprimer les schémas sous une forme plus détaillée ou les consulter ultérieurement, sélectionnez
‘File > Print from Logger Setup’ (Fichier > Imprimer depuis la configuration de I'enregistreur).

L’exemple ci-dessous montre le capteur de thermocouple différentiel de type K réel raccordé a
I'enregistreur 2020 dans le schéma de cablage de gauche.

= Range Selection 3]

Add/Edit Scaling

Ranges available

Pl -200 to 1372 °C.
| [-328t0 2501 F

Voltage - Dif jal
Voltage - Single ended

Current

D Thermocouple - Differential

5 Thermocouple - Single ended A
C Thermacouple - Single ended
D Thermacouple - Single ended
) Thermocouple - Differential
KTh

[N Thermocauple - Differential
R Thermocouple - Differential

S Thermocouple -Differentsl ¥
The Reference Junction is required fo logging of Thetmacouples and wil be set automatically
Unsset chamel | oK Cancel
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Cablage d’alimentation du capteur Entrée haute tension

T

I
Enregistreur SIS Seos
non régulé
Sortie A .
d’alimentation Négatif Vi(+ve) V2(-ve)
@] [O] ( )
Sortie 5 V régulée — ( V1(-ve) — V2(+ve)
C { )

Cablage de la prise E/S

Broche Connexion

BROCHE 1

1. Evénement/Etat Entrée 1
2. Evénement/Etat Entrée 2
3. Evénement/Etat Entrée 3
4. Evénement/Etat Entrée 4
5. Evénement/Etat Entrée 5
6. Evénement/Etat Entrée 6
7. Evénement Etat Entrée 7
8. Evénement Etat Entrée 8
|1 ] | 9. Masse
10. Alarme Sortie A
1. Alarme Sortie B
12. Alarme Sortie C
13. Alarme Sortie D
14. Sortie auxiliaire +ve
15. Sortie auxiliaire +ve
16. Sortie auxiliaire -ve
17. Sortie auxiliaire -ve
18. Masse
19. Masse
20. Masse
21. Impulsion rapide Entrée 1
22. Impulsion rapide Entrée 2
| IMPULSION | IMPULSION 23. Impulsion lente Entrée 1
LENTE I/P 1-2 RAPIDE I/P 1-2 24. Impulsion lente Entrée 2
25. Sans connexion

Lecteur de carte mémoire externe

Le connecteur de carte SD externe est situé dans le
compartiment des piles.

SQ2020/40 18108 Version 17
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8. Accessoires

Grant Instruments propose un large éventail d’accessoires qui complétent la gamme
d’enregistreurs de données Squirrel. Ces accessoires comprennent des adaptateurs comme
illustrés ci-dessous qui permettent de contacter votre enregistreur de données Squirrel a distance.
lls sont tous trés faciles a installer et se raccordent directement a I'enregistreur via le connecteur
RS232. Pour des informations plus détaillées ou pour passer une commande, contactez Grant ou
votre fournisseur local.

GSM

Sans fil

Ethernet

A | |

wy 1 ATDmeme g

]
Model No: AMC232LANO1 -

jce ==

1

Référence :
Convertisseur RS232 vers Ethernet composé d’'un boitier adaptateur et d’'un cable
d’installation du modem. Le logiciel de configuration Ethernet convient uniquement
aux systémes d’exploitation Windows 2000 et XP. SQ20A801

Kit modem GSM comprenant un modem, un cable de connexion Squirrel,
un cable d’alimentation et une antenne avec 3 m de cable. Une carte SIM compatible
données de votre fournisseur d’acceés au réseau est également nécessaire. SQ20A802

Adaptateur sans fil comprenant un adaptateur RS232 pour raccorder I'enregistreur

au PC selon un débit pouvant atteindre 115 K2 avec une portée jusqu’a 200 métres

en utilisant la bande de fréquence a 2,4 GHz. Le kit est fourni avec tous les cables

de raccordement.

Remarque : alimentations électriques (MPU 12 V) a commander séparément SQ20A803

18108 Version 17 SQ2020/40
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Référence :
Option de mémoire externe amovible
Carte mémoire SD. MMC64

Progiciels de configuration, de transfert et d’analyse des données :
SquirrelView Plus
Offre une analyse compléte des données, des graphiques en ligne, un compteur

Excel et une fonction d’exportation vers Excel SQA200
Licence multi utilisateurs SquirrelView Plus
Utilisation illimitée de SquirrelView au sein d’'une méme entreprise. SQA300

Certificats d’étalonnage pour la série Squirrel 2020/40 (toutes gammes)
Remarque : Les tests et les certificats d’étalonnage de Grant Instruments
sont tragables selon les normes nationales

SQ2020 CAL2020
SQ2040 CAL2040
Boitier étanche

Robuste boitier étanche en plastique PEL4
Support mural

Support mural et de bureau en acier inoxydable WB6

Alimentations électriques
100 a 240 V CA a 50/60 Hz fournies par 3 prises secteur individuelles pour le R-U,

I'Europe et les Etats-Unis MPU 12 V
MPU 12 V normal, mais fourni avec un fil volant de 1 MPU 12 VFL
Batterie rechargeable (12 V, 6 Ah) SQ20RB12-6
Batterie rechargeable (12 V, 15 Ah) SQ20RB12-15

Connecteur d’interface E/S numérique
Connexion soudée miniature de type connecteur D sub 25 voies avec couvercle

pour entrées numériques, entrées d’alarme et d'impulsion SB102
Dérivations de courant

Paquet de 4 résistances de précision pour canaux analogiques 4 a 20 mA CS202
Cables de raccordement entre enregistreurs de données et ordinateurs/modems.

Port série Squirrel vers PC LC71
Port USB Squirrel vers PC LC77
Squirrel vers modem LC73
Cable d’alimentation 12V CC

Connecteur 2,1 mm CC avec fusible et cable 1,8 LC76
Borniers

Borniers enfichables avec retenue de cable

3 voies 14174
4 voies 13975
6 voies 18097

Sondes thermiques et d’humidité

Grant propose une gamme de sondes thermiques et d’humidité convenant a I'utilisateur avec des
enregistreurs de données et d’autres systémes de mesure compatibles. Des sondes sur mesure ou
spécialisées sont également disponibles. Contactez nous pour vos demandes de sondes spécialisées.

SQ2020/40 18108 Version 17
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9. Spécifications

ENTREES ANALOGIQUES
Précision de base (5 a45°C) : .........ccocoiiiiiiiiiiiiiiiie * (valeurs 0,05% + plage 0,025%)
Rejet en mode courant @ ..............oiiiiiiiiiii e 100 dB
Impédance d’entrée @ ..o >1 MOHM
Linéarité : ...................... s 0.0015%
Rejet en ligne mode S€rie : ............ccoociiiiiiiiiiii e 50/60 Hz 100 dB
Effet du champ électromagnétique et de la RF conduite : ..............cocvvniiniinnne <1% ¥
ENTREES NUMERIQUES
Sans tension d’entrée................ccocoiinii, 0a 0,5V (ou entrée court-circuitée)
Une tension d’entrée
Protection d’entrée ............... activée en-dessous -0,5 V environ et au-dessus d’environ 6 V
CONVERSION ANALOGUE-NUMERIQUE
L T TSP OUPR Sigma-Delta
Résolution : .................. 24 bits
Taux d’échantillonnage : ................cccooiiiiiiiin. Jusqu’a 20/100 lectures par seconde
Remarque : Le mode 100 Hz n’est pas disponible sur les modéles 1F8
SORTIES D’ALARME .........ocoiiiiiieeeee e 4 x FET ouvertes (18 V 0,1 A Maxi)
ALIMENTATION ELECTRIQUE
DU CAPTEUR .......cccoiviiiiiiiieiieeee 5V CC régulées (50 mA) ou tension d’alimentation (100 mA)
HEURE ET DATE ... Horloge intégrée a 3 formats
ECHELLE DES DONNEES ................. Affiche les valeurs dans les unités techniques de prédilection
MEMOIRE
Interne @ ... 128 Mo (jusqu’a 14 400 000 lectures)
Externe @ ... Jusqu’a 1 Go sur carte amovible MMC/SD
RESOLUTION ......ooooiimiiiiiioeeeee e Jusqu’a 6 caracteéres significatifs
PROGRAMMATION/CONFIGURATION
DE L’ENREGISTREUR ...t Logiciel SquirrelView ou SquirrelView Plus
COMMUNICATION ..ot USB 1.1 et 2.0 / RS232 / Ethernet (sauf 1F8)
OPLION INEEINE & ... et e et e e e e e e et e e e e e e e nneaeeeaens Wi-fi
Options eXtEerNeS & ........coooiiiiiiii e GSM, Ethernet et sans fil

ALIMENTATION ELECTRIQUE
Interne : ... 6* piles alcalines AA
Externe : ...........cc.......... 10 a 18 V CC, polarité inverse et protection contre les surtensions

1 Cet effet peut étre plus grand a 288kHz, réorienter les cables d'entrée ou ajouter une
perle de ferrite axiale appropriée prés de I'enregistreur s'il y a lieu.

* La température de fonctionnement maximale pour les piles alcalines AA fournies est
de 50°C
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CONSOMMATION ELECTRIQUE @ 9V
Mode VEIlIE & ... e <600 pA
Enregistrement @ ... 40 2 120 mA

DIMENSIONS ET POIDS

Enregistreur 2020

DIMENSIONS & ..o L 235xP 175 x H 55 mm

Poids : ................... Environ 1,2 kg

Matériau du boTtier © ..o ABS

Enregistreur 2040

DIMENSIONS & ..o L235xP 175 xH 92 mm

Poids : .......ccoeiiiiies

Matériau du DOTHEr .............ooiii
MODES MEMOIRE (interne seulement)...................... Arrét en cas de saturation ou d’effacement

AFFICHAGE ET PAVE DE TOUCHES
LCD 2 lignes x 20 caractéres

ENVIRONNEMENT DE FONCTIONNEMENT ..., -30°C a +65°C

Windows est une marque déposée de Microsoft Corporation aux
Etats-Unis et dans d’autres pays.

Dans le cadre de notre politique d’amélioration continue, les spécifications sont susceptibles de
changer sans préavis.

Grant est persuadée que toutes les informations déclarées sont correctes lors de la publication.
Aucune responsabilité n’est acceptée pour toute erreur ou omission.
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Nach dem Durcharbeiten dieser
Anleitung finden Sie in der Hilfe in
SquirrelView (F1 drucken) weitere
Informationen Uber diesen
Datenlogger und seine
Verwendung mit der Software.
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1. Hardware-Checkliste

C
Grant
ager

pata Lo
squirre! SERES
202012040 Getting

A) Datenlogger SQ2020/2040

B) USB Laufwerk mit Software (SQA100)

C) Kurzanleitung fir die Inbetriebnahme (dieses Dokument)

D) USB-Kabel (LC77)

E) Montageblech fir Datenlogger (WB6)

F) 6 AA-Batterien

G) Stromnebenschlusswiderstande fir Eingange 4 bis 20 mA,
10 R x 4 (CS202)

H) Anschlussleisten: 4 x 6-polig (18097), 4-polig (13975),
3-polig (14174) mit Kabelschellen

Hinweis:  Der Datenlogger 2040 wird mit 4 zusatzlichen 6-poligen
Anschlussleisten (18097, siehe oben) geliefert.
Die Wi-Fi-Version fur die drahtlose Kommunikation wird
dartber hinaus mit Antenne geliefert.

SQ2020/40 18108 Version 17
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2. Allgemeine Informationen

21

2.2

N

Einlegen der Batterien

Die Serie 2020/2040 wird mit 6 AA-Batterien betrieben, die sich in einem mit Deckel
versehenen Batteriefach befinden. So setzen Sie neue Batterien ein bzw. wechseln
diese aus:
1. Offnen Sie das Batteriefach, indem Sie den Batteriefachdeckel nach unten
driicken und herausschieben (siehe Abbildung).
2. 6 AA-Batterien* einlegen; dabei ordnungsgeméafe Polung beachten.
3. Batteriefachdeckel einsetzen

* Es wird empfohlen, in einem Satz nur Batterien des gleichen Herstellers, Typs und
Ladezustands zu verwenden.

Wichtiger Hinweis: Die Batterien sollten aus dem Gerat herausgenommen werden,
wenn der Datenlogger ldngere Zeit nicht benutzt oder transportiert wird.

Stromversorgungsanzeige

Batterieladestand

Bitte vergewissern Sie sich, dass die Batterien einen zum Abschlief3en eines
Messwerterfassungsdurchlaufes ausreichenden Ladestand besitzen. Sie kénnen den
Ladestand auf der Batterieladestandsanzeige in der rechten oberen Ecke des
Displays uberprifen.

BATTERIE BATTERIE
VOLL LEER

Anzeige Externe Stromversorgung
Der Datenlogger kann aus einer externen Stromversorgung (10-18V DC) gespeist
werden.

Wichtiger Hinweis: Zum Schutz von Daten im Falle eines unerwarteten
Stromausfalls miissen die Batterien beim Geréatebetrieb eingelegt sein.

18108 Version 17 SQ2020/40
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3. Kommunikation mit dem Datenlogger

3.1 Installation der Software

Eine ausfuhrliche Installationsanleitung finden Sie in der ,Software Installationsanleitung*.
Die folgenden Schritte geben Ihnen Informationen zur Schnellinstallation.

1. Sie mussen auf dem PC, auf dem Sie die Software installieren méchten,
Administratorrechte besitzen.

2. Alle Grant Anwendungsprogramme mussen geschlossen sein.

3. Stecken Sie den USB-Laufwerk in den USB-Port Ihres Computers, 6ffnen Sie das
USB-Laufwerk und starten Asie die .Exe-Programm

4. Folgen Sie den Anweisungen des Installationsassistenten.

Wichtiger Hinweis: Vergewissern Sie sich vor dem AnschlieBen des Datenloggers,
dass die Software installiert ist.

3.2 AnschlieBen des Squirrel Datenloggers

Sie kénnen mit einer der folgenden Methoden eine Verbindung zum Datenlogger herstellen:

1. Serielles RS232-Anschlusskabel mit seriellen Adaptern
2. USB

3. Ethernet (falls vorhanden)

4. Wi-Fi (falls vorhanden)

Nachfolgend finden Sie weitere Informationen.

Serielle RS232-Schnittstelle

Informationen zur Verwendung der seriellen Adapter finden Sie in der SquirrelView Hilfe.
Bei Verwendung eines direkten RS232-Kabels ist ein Kabelende an die serielle Schnittstelle
des Datenloggers und das andere Ende an die serielle Schnittstelle des PCs
anzuschlieRen. Sobald das Kabel angeschlossen ist, kann der Datenlogger mit dem PC
kommunizieren.
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usB

Schlielen Sie das eine Ende des mitgelieferten USB-Kabels an den Datenlogger und das
andere Ende an den PC an.

Wenn der PC den Datenlogger erkannt hat, installiert er automatisch die USB-Geréatetreiber.

Win 7/Vista - Die USB-Geratetreiber werden automatisch installiert und es sind keine
weiteren Schritte notwendig.

Win XP - Die USB-Treiber wurden wahrend der Installation bereits installiert, sodass der
Assistant die Treiber automatisch finden kann. Wahlen Sie im Assistenten fiir das Suchen
neuer Hardware die Option ,Nein, dieses Mal nicht* und bei allen anderen Fenstern
Weiter”, um die Installation abzuschlieRen.

Found New Hardware Wizard Found New Hardware Wizard
Welcome to the Found New e
Hardware Wizard

‘Windows will search for current and updated software by
looking on your computer, on the hardware instaliation CD. of on
the Windows Update Web site (with your permission).

Read ow privacy policy

This wizard helps you installsoftware for.

Grant Instruments 20xx USB Driver

() 1f your hardware came with an installation CD

CanWindows connect to Windows Update to search for & or floppy disk. insert it now.

software?

© Yes, this time only

‘What do you want the wizaiddado2,

and every time | connect a device

Q instal the software automalicaly (Hecommended)

T

Click Next to continue.

Click Next to continue.

Klicken Sie im Hardwareinstallations-Warnhinweisfenster fir den Windows Logo-Test auf
Trotzdem fortfahren. Nach Abschluss der Treiberinstallation kann der PC mit dem
Messerterfasser kommunizieren.

Falls Probleme auftreten, sollten Sie unter ,Troubleshooting->20xx USB Drivers* in der
SquirrelView Hilfe nachlesen.

18108 Version 17 SQ2020/40
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Ethernet

Vor der Verwendung der Ethernet-Verbindung sollten Sie das Konfigurationshandbuch
(,~\SquirrelView\Manuals\SQ20xx Inbuilt Ethernet Configuration.pdf*, hierbei ist
,~\SquirrelView" das Installationsverzeichnis von SquirrelView) lesen. SchlieRen Sie ein
Netzwerkkabel, das an eine Netzwerkbuchse Ihres Netzwerks eingesteckt ist, an den
Ethernet-Netzwerkanschluss des Datenloggers an.

10-18V DC

“o*
_/70 ’ )

A Die Ethernet-Option ist nur verfiigbar, wenn der Datenlogger an eine externe
Stromversorgung angeschlossen ist.
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Wi-Fi
Vor dem Verwenden der Wi-Fi-Anbindung muss die Antenne an den Datenlogger
angeschlossen werden (siehe folgende Anweisungen).

1. Schrauben Sie die Antenne auf die Gewindebuchse und richten Sie diese wie die
an den PC angeschlossene Empfangerantenne (normalerweise vertikal) aus.

2. SchlielRen Sie das externe Netzteil an den Datenlogger an.

3. Wenn Sie das Gerat einschalten, beginnen die gelben und griinen Lampchen am
Modul zu blinken. Die Verbindung wurde hergestellt, wenn das gelbe Lampchen
aufhort zu blinken und kontinuierlich leuchtet.

Informationen zum AbschlieRen der Installation finden Sie im Konfigurationshandbuch
(,~\SquirrelView\Manuals\SQ20xx Inbuilt Ethernet Configuration.pdf*, hierbei ist
~\SquirrelView" das Installationsverzeichnis von SquirrelView).

Die Wi-Fi-Option ist nur verfiigbar, wenn der Datenlogger an eine externe
Stromversorgung angeschlossen ist.
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4. Beispiel

Nach der Installation von SquirrelView wird in das SquirrelView-

Installationsverzeichnis eine Konfigurationsbeispieldatei kopiert. In diesem Beispiel
wird die Innentemperatur des Datenloggers erfasst.
Wenn Sie sich mit der Funktionsweise des Datenloggers vertraut machen wollen, ist
dieses Konfigurationsbeispiel sehr nitzlich.

4.1 Aufrufen von SquirrelView und Auswahl des Datenloggertyps
Klicken Sie auf das SquirrelView-Symbol auf lnrem Desktop oder wéahlen Sie
SquirrelView aus dem Windows-Startmenu. Nach dem Start des SquirrelView-
Assistenten sollten Sie Uberprifen, ob der richtige Datenloggertyp und die richtige
Kommunikationsmethode eingestellt sind.

Der Datenloggertyp wird im SquirrelView-Assistenten angezeigt. Falls Sie daran
Anderungen vornehmen méchten, klicken Sie in der Symbolleiste des Assistenten auf
,Logger Selection® oder rufen den Kommunikationsassistenten auf. (Hinweis: Die
voreingestellte Kommunikationsmethode ist USB und muss im
Kommunikationsassistenten gedndert werden, wenn Sie eine andere
Kommunikationsmethode verwenden méchten.

4.2 Synchronisieren des Datenloggers mit dem PC
Es wird empfohlen, zuerst die Uhrzeit des Datenloggers mit der des PCs zu

synchronisieren.

O Klicken Sie
im SquirrelView
-Assistent auf

® Wahlen Sie im
Bildschirm ,Logger
Setup” die

(TR

Logger Control | _ Actions & Triggers Cont

Logger Date / Time:

Set Logger Time Manualy
Set Logger Time to PC Time

sLogger Registerkarte ,Logger
Setup*. Il Control. Klicken Sie PCTime:  20/10/20031530.08
auf ,Set Logger Time Logger Date Format:  [DD/MMAY ~
to PC Time“ und dann |Lnggev Identiicaton
. Logger ID
LDQQEI’ SEtUD () (This text is used to identify the logger)
SQ2020/40 18108 Version 17
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4.3 Aufrufen des Demoprogramms

O Klicken Sie im SquirrelView | SquirrelView Assistant
Assistenten auf ,Logger Grant SquirrelView-Ass|
Setup®, um den Bildschirm OATA TOGGIG

sLogger Setup” zu 6ffnen. In
diesem Fenster kdnnen Sie
mithilfe von File -> Open die
Demo-Konfigurationsdatei
6ﬁnen' Wahlen Sle dle Ihrem Previous Files Used: (Double Click To Open)
Datenloggertyp entsprechende e

Datei. (e oroaram Fle s U ehem S S FIes auick sCart dems 176220
¢:\program files\squirrelview\setfles\quick start demo 28,620

Squirrel  Analysis Tools Logger Selection Help

= ) @ ®m o

Logger Setup  fDownloadData  Analysis Meter Mode  Logger Control - Communication
Wizard

Logger Type

2010

Remove Clear

® Jetzt wird der
Bildschirm L Logger Setup (Quick Start Demo 1F8) - For 1F8 Loggers (=163

,,Logger Setup“ File 'Sju\rrel view Options Help
angezeigt. Hier | —= FEEILL. LI

kénnen Sie die ||., lli
o
o ||Mot Set Mot Set = Mot Set
Erfassungspara || £
meter 5 [[Het Set Mt Set c Mot Set
A E Mot Set Mot Set C Mok Set
einstellen. o
% Mot Set Mot Set c Mot Set
3
. . Mot Set Mot Set o Mot Set
Gehen Sie in J
Mok Set Mot Set o Mok Set
der Mot Set o Mok Set
Registerkarte ||z
g Mot Set o Motk Set \
JActual .
« i Ref, Junckion 1 Internal 9 Sample Interval; A (00:00:01) Logging Interval: (00:00:01) Mode: Inter
Channels® in —
High voltage 1 F Mok Set
der Spalte High Woltage 2 F Hot Set
; .
~Sensor Type o[
Zu uRef- Logger Control T Actions & Triggers T Configuration T DigitalfState T Alarms ]
Junction 1“
. Logger Date [ Time Logger Identification Memory Made
DS G CED Set Logger Time Manuall | My New Logger Memary Mode | Stop when ful =
Eingang, von e g (Thistext s used to dentfy the logger)
R R Set Logger Time to PC Time
dem in diesem e =
Be|sp|e| PC Time 24/10{2006 12:50:14 m Delayed Start -
gelesen wird. I Enable -
e Sensor Power Timers
A(Supply) [on:00 T8 j‘ [ Continuous B{(5¥) (o0:00: T j‘ I™ Continuous =]
Im Feld ,Job

Description® & Commurication |
konnen Sie die
Konfiguration

18108 Version 17 SQ2020/40
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@ Klicken O Klicken 0O Klicken @ Klicken

Sie auf Sie hier, Sie auf Sie auf
dieses @ um den @ dieses sLogger @
Symbol, ’ Symbol, Control*,

um die wenn vom um den
Konfiguration zum SquirrelView betreffenden Status des
Datenlogger zu Assistenten Eingang Messwerte Datenloggers
senden und mit der aufzurufen. in Echtzeit erfasst anzuzeigen.
Messwerterfassung werden sollen.

zu beginnen.

Lassen Sie das

Gerét einige

Minuten lang Daten

erfassen.

@n Fenster = Loggen Control l

,Logger Control* Squirrel View

Werder.] [ Y| & ¥ BB (2

verschiedene

Statusinformation ger Information Memary

en angezeigt. / :ﬂLoggar () Lagger ID ﬁlﬂlnternal Memaory Total 15616 KB
aB)5erial Number k50617012 Efinternal Memary Used 14496 KB

. . :@]Luggar Type ZFG ﬁlﬂlntemal Memary Free 1120 KB

K.I|0ken Sie auf B, ogger state Disarmed

die

Stoppschaltflache

, um die

Messwerterfassun ]
Date and Time Power Supply

g zu beenden. =
3] agger Time 23{10j2006 12:37:03 Binternal Supply 0oy
:ﬂstatus Last Updated 23/10/2006 14:36:49 ﬁlﬂExternal Supply 1z
3P Time Z3/10/2006 14:35:49

O Klicken Sie im SquirrelView-

Assistenten auf das Symbol

,Download Data“, um Daten vom

Datenlogger herunterzuladen. Download Daka

SQ2020/40 18108 Version 17
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X

! Download
Squirrel  View

Logger Data Files

04120547 04135524 04145536 04150726 05095550 14153917

Lagaer Data File Information

Data file 04120547

JDb Description fillup

3] arm Time 04/07/2006 12:05:47
3B pisarm Time 04/07/2006 13:30:17

14153923 041359950 04140004 04140019 0S071157 5.07 MB
Down\oaded Yes
Action After Download |Exp0rt Data j Advanced | Download Selected File(s)

Mo Ackion
Expart Data
® In diesem Fenster kénnen Sie jetzt die Messwertdatei herunterladen und den Export-

Assistenten aufrufen oder die Messwertdatei in das Analyseprogramm®* laden (weitere
Informationen finden Sie unter ,Herunterladen von Daten®).

Die Messwertdatei erhélt einen eindeutigen
Namen (e.g. 28162735.D20). Eine 28 D20
Erlauterung des Dateinamens finden Sie in '

der rechten Abbildung; hier werden Datum [TIME@4HR)|

und Startuhrzeit dargestellt.

In diesem Beispiel laden Sie die Messwerte in das Analyseprogramm®. Beginnen Sie
mit der Auswahl der Messwertdatei und der Diagrammart und klicken Sie dann auf
,Download Selected File(s)". Sie werden zum Speichern der Messwertdatei
aufgefordert, und dann werden die Daten zur Anzeige umgewandelt.

@ Nach Abschluss der Decodierung wricrne

wird das Fenster ,Analysis File = Quisk S Roms S—
Description” angezeigt. Klicken Sie auf EET e : ‘ -

,OK*, um die Daten anzuzeigen. 35 s ! e

2
EN

/A I
Sioer e ]
&% [ J f
] i
f |

N
Analysis File Description 56 6

P W s
Enter a unique description for the new Analysis File Rea Tme

[Quick Start Demo|
-

8/07/2004 133231050 vl 21

< i B Y Croirie

*Nur mit SquirrelView Plus verfligbar.
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5. Herunterladen von Daten

Datenlogger

Messwert L e
dateien
el (.d20) Analyse
(.d20) Analysedatei
(nur SquirrelView
Plus)

/

Messwertd Lgsfm -
ateiin | Odu — -
externer a i
MMC/ ”

SD-Karte SquirrelView

Datei mit durch Kommas
getrennten Werten

In der obigen Abbildung ist der Herunterladevorgang dargestellt. Die vom Datenlogger erfassten
Daten werden in seinem internen Speicher abgelegt und kdnnen mithilfe von SquirrelView
heruntergeladen werden.

Bevor die Messwerte angezeigt werden kénnen, missen Sie von SquirrelView fir die Analyse
oder (je nach verwendeter PC-Software) in das CSV- oder XLS-Format umgewandelt werden.

Diese Konvertierung kann von SquirrelView mithilfe von drei Methoden durchgefiihrt werden:
— im SquirrelView-Assistant (Analysis->Export Data File)

— automatisch beim Klicken auf die Schaltflache ,Download Data“ in SquirrelView*

— oder im Fenster ,Logger Data Analysis“ durch Auswahl von ,File->Import Data“*

Nach dem Herunterladen der Datei kénnen Sie auf diese doppelklicken, und sie wird mit dem
unter ,Tools", ,Preferences*, ,File Association Action“ angegebenen Programm gedffnet.

*Nur mit SquirrelView Plus verfligbar.

SQ2020/40 18108 Version 17
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6. Menu und Navigation

6.1 Bedienelemente
Die folgende Abbildung zeigt die Bedienelemente des Gerates.

NACH
RECHTS/UNTEN

EINGABETASTE/
BESTATIGEN &
EINSCHALTEN

ESCAPE-TASTE/
ZURUCK

(kehrt zum vorigen
Menu zurtick)

e ¢ D

A |
‘ (4
4

Driicken Sie die Taste O um die

Bedienelemente des 2020/2040 zu --Main Meru------- .
aktivieren. IE' kl__{ i @ r
Das Display schaltet sich per Tf

Voreinstellung nach 10 s ab; sie kdnnen

dies jedoch in der Registerkarte Log Comtrol

,LConfiguration“ im Fenster ,Logger Setup’
von SquirrelView andern.
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6.2 Systemmenii
Im Folgenden finden Sie eine grundlegende Erklarung der Hauptmenustruktur. Weitere
Informationen zur gesamten Menustruktur finden Sie in der Online-Hilfe (,Help->Help
Content->Loggers”) in SquirrelView.

6.2.1  Menii Log Control* --Main Mema------- .
In diesem Meni kdnnen Sie den Datenlogger IE LE
aktivieren und deaktivieren. D

¥

Log Control

6.2.2 Menu ,Meter” — -Maif Mefd-------
Hier kénnen Sie jeden Kanal in Echtzeit
(1 - 2 Hz) sehen. Durch Driicken der P . B D
Eingabetaste kdnnen Sie den jeweiligen Tf
Kanal grafisch darstellen.
Meter
6.2.3 Menii ,Status* - -”am Mer- - - - - - -
Im Statusmenu erhalten Sie Informationen 1:"‘...-_" |1| B D
zum Datenlogger, wie z. B. verfugbarer D
Speicher und Betriebsspannung. Darliber Tf
hinaus kénnen hier auch die Alarmausgange Status
deaktiviert werden.
6.2.4 Menu ,Setup” . --Ha1n TP TV ——
Uhrzeit, Datum, Kanal-Basiskonfiguration,
Speichern und Abrufen von LE . D
Geratekonfigurationen und D Tf
Startverzégerungen.
Setup
Weitere Informationen zur Basiskonfiguration
finden Sie in Abschnitt 6.3.
--Main Memu------- [ |

625 Meni ,Data Files* b i B[]

In diesem Menu kénnen Sie Messwertdateien D
auf eine externe Speicherkarte (falls Tf
vorhanden) kopieren und die
Messwertdateien aus dem internen Speicher
des Datenloggers I6schen.

Data Files

6.2.6 Menii ,Tools" --Main Menu------- s
Das Menii ,Tools* enthalt Wartungsfunktionen e 1B
wie z. B. Abfragen der Softwareversion bzw. D
IP-Adresse des Datenloggers, Ausfihren
eines Selbsttests und Reset des Tools
Datenloggers.

SQ2020/40 18108 Version 17
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6.3 Erstellen einer Basiskonfiguration

Der 2020/2040 ermdglicht das Erstellen einer Kanal-Basiskonfiguration einschlief3l.
Messwerterfassungsintervall, Sensortyp und Sensorspeisung (Anregung) Uber die
grafische Benutzerschnittstelle. Eine vollstdndige Konfiguration komplexerer
Funktionen ist Uber die mitgelieferte SquirrelView-Software durchfiihrbar. Nachfolgend
finden Sie eine kurze Erlauterung zum Erstellen einer Kanal-Basiskonfiguration mithilfe
der grafischen Benutzeroberflache.

--Setup----------- [ |

6.3.1 Kanalkonfiguration ?ﬁ"t‘ggﬁa?g“er
Wabhlen Sie im Hauptmen( die Option ,Setup* B> |
und dann ,Channel Setup”. D;?Eﬁed-g};:gi

Date /Time
Configuration

6.3.2 Kanal hinzufiigen oder bearbeiten - _Channel Setup--- B
Im Menii ,Channel Setup® kénnen Sie alle Clear Channels
Kanale zurlicksetzen, einen Kanal hinzufigen/ D 1En anne
bearbeiten, Kanalinformationen anzeigen oder Delete Channel
einen Kanal I6schen. Wahlen Sie ,Add/Edit
Channel*.

6.3.3 Hinzufligen eines neuen Kanals -

im Ment: Add/Edit Ghannel werden aktuel R T .
konfigurierte Kanale angezeigt, und sie

kénnen hier weitere Kanale hinzufiigen. D

Wahlen Sie ,Add Channel“.

6.3.4 Kanalkonfiguration --Chatnel Setup--- @
Wahlen Sie flir den Kanal den Sensortyp, anae
Messbereich und (bei Bedarf) die Senzor Fower Timer
Sensorspeisung (Anregung) aus.

6.3.5 Anzeigen der Kanalkonfiguration -tlisw Chfhhel ----
Wenn Sie alle gewlinschten Kanéle 2T JuRction
hinzugefligt und konfiguriert haben, kénnen
Sie sich die Anschlusskonfiguration unter
,View Channels" anzeigen lassen.

Bitte beachten Sie, dass Kanalparameter je - U
nach Typ des am betreffenden Kanal sopiew Channel---- @
angeschlossenen Sensors automatisch él‘“{c't kL!%E-d
zugewiesen werden. Diese Parameter kénnen e
bei Bedarf mithilfe der SquirrelView-Software (=
geandert werden.
18108 Version 17 SQ2020/40
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6.3.6  Konfiguration des Zeitintervalls fir die - -Imteruals------- []
Messwerterfassung Wenn Sie das Zeitintervall e
direkt am Gerat konfiguriert haben, wird dieses D
allen Kanalen zugewiesen. Sie kdnnen
dieses Intervall unter ,Intervals” im Hauptmen
~Setup® anzeigen oder andern.
6.3.6  Konfiguration der Sensorspeisung --Sensor Timer A-- @
Die Sensorspeisung kann unter ,Sensor )
Power* im Hauptmenu ,Setup” geandert B ﬁ??’f:\;uc‘ﬁ
werden.

A Wichtige Hinweise zum Einstellen von Parametern direkt am Gerat

SQ2020/2040 Datenlogger sind in vollem Umfang mithilfe der SquirrelView Software
konfigurierbar. Bei der Konfiguration direkt am Gerat sind die folgenden Punkte zu
beachten:

. Normalerweise wird allen Kanalen das gleiche Zeitintervall fir die Messwerterfassung
(Intervall A) zugewiesen. Bei komplexeren Konfigurationen (mit unterschiedlichen
Zeitintervallen) kénnen jedoch alle Zeitintervalle mithilfe der SquirrelView-Software
angezeigt werden.

. Zum Vermeiden von Problemen mit der Anschlusskonfiguration kdnnen die Parameter
der einzelnen Sensortypen (auller Messbereich und Sensorspeisung) nicht mehr
bearbeitet werden, sobald sie eingestellt wurden. Wenn der Sensortyp eines Kanals
geandert werden soll, missen Sie diesen Kanal zuerst I6schen.

. Wenn die Sensoranzahl beim Hinzufligen neuer Kanale uberschritten wird, erscheint
die Meldung ,Ungliltiges Setup®.

. Von SquirrelView berechnete Kanalkonfigurationen werden unter ,View channels” nicht
angezeigt.
. Die Vergleichsstelle kann nicht geléscht werden, wenn ein zu konfigurierender Sensor

(z. B. Thermoelement A) diese zum ordnungsgemafen Betrieb bendtigt.

. Die Konfiguration eines Datenloggers kann nicht gedndert werden, wenn er Messwerte
erfasst.
. Die Meldung "Sub-sekiindliche Rate" wird angezeigt, wenn ein Abtastintervall unter

1 Sekunde angezeigt oder bearbeitet wird. Mit dem Squirrelview Logger Setup kénnen
Sie die Intervalle anzeigen und bearbeiten.

SQ2020/40 18108 Version 17
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7. Anschlusse

Analogeingédnge

ﬁBLOCKH BLOCK | [BLOCK |
S

12A45m 12C45m 1E3

Analogans
chliisse an
der
Geréaterlick
seite

12B45m 12D45m 12FA4

BLOCK |_ BLOCK | BLOCK
B D F

BLOCK BLOCK
G J

Analoganschl
Usse an der
AT e Geréteriicksei

BLOCK BLOCK
H K

12G45m 12J 4 5m

HINWEIS: Die oben dargestellten Blocke G bis
K sind nur beim Modell 2040
verfligbar.

Da die Anschlusskonfiguration vom verwendeten Sensortyp abhangt, wird sie wahrend des Setups
in SquirrelView angezeigt. Beachten Sie beim Anschluss des gewiinschten Sensors das
Anschlussdiagramm. Wahlen Sie ,File > Print from Logger Setup“, wenn Sie die Diagramme

ausdrucken oder spater verwenden mdéchten.

In der folgenden Abbildung ist ein Differenzial-Thermoelement vom Typ K an einen Datenlogger der
Serie 2020 gemaR des linken Anschlussdiagramms angeschlossen.

= Range Selection X
Sensor Type Ranges avalable
Resistance - 2 Vire Pl 200 to 1372 °C B Raee
[Resistance - 3 Wire | |-328t0 2501 °F -
Resistance - 4 Wire
Voltage - Differential Edlt Range
Voltage - Single ended
Current
U Thermistor Add/Edit Sealing

B Thermocouple - Differential
C Thermocouple - Differential
D Thermocouple - Differential

-Single ended A
C Thermocouple - Single ended
D Thermocouple - Single ended
) Thermocouple - Differental

[N Thermocouple - Differential
R Thermocouple - Differential
S Thermocouple - Differential ™

The Reference Junclion is required for logging of Thermocouples and will be set automatically

Cancel

=]

Un-Set Channel |
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Anschlussbelegung fiir die Sensorspeisung Hochspannungseingang

0

o[-
Nicht geregelter TTTT
Datenlogger
Betriebsspannungsau Minuspol V1(+Ve) V2(-Ve)
sgang
@] [e ( b
Geregelter — V1(-Ve) T V2(+Ve)
5V-Ausgang % \ / *)

Belegung der E/A-Anschlussbuchse

EREIGNIS/ Stift Anschlussbelegung
SE-l;é-l;l_JBS STIFT 1 1. Ereignis/Status Eingang 1
2. Ereignis/Status Eingang 2
3. Ereignis/Status Eingang 3
4. Ereignis/Status Eingang 4
5. Ereignis/Status Eingang 5
6. Ereignis/Status Eingang 6
7. Ereignis/Status Eingang 7
8. Ereignis/Status Eingang 8
|1 ] | 9. Erde
10. Alarmausgang A
1. Alarmausgang B
12. Alarmausgang C
13. Alarmausgang D
14. Zusatzausgang +Ve
15. Zusatzausgang +Ve
16. Zusatzausgang -Ve
17. Zusatzausgang -Ve
18. Erde
19. Erde
20. Erde
| +Ve 21. Schnellpulseingang 1
22. Schnellpulseingang 2
LANGSAMPU SCHNELLPUY 1 23. Langsampulseingang 1
LS S = 24. Langsampulseingang 2
E/P 1-2 E/P 1-2 25. Nicht belegt

Steckplatz fiir externe Speicherkarte

Der Steckplatz fiir die externe SD-Karte befindet sich
im Batteriefach.
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8. Zubehor

Grant Instruments bietet eine Vielfalt an Zubehor zur Erganzung der Palette an Squirrel
Datenloggern an. Dazu gehdren die unten dargestellten Adapter zur Fernsteuerung des
Datenlogger. All diese Zubehérkomponenten sind einfach zu installieren und tber die RS232-
Schnittstelle direkt an den Datenlogger anschlieBbar. Wenden Sie sich an Grant Instruments bzw.
Ihren lokalen Fachhandler, falls Sie weitere Informationen bendtigen oder Zubehor erwerben
mochten.

GSM

WLAN

Model No: AMC232LANO1 3

1 CE ===

Art.-Nr:
RS232-Ethernet-Konverter mit Adapterbox und Modemsetup-Kabel.
Die Ethernet-Konfigurationssoftware 1auft nur unter Windows 2000 und Windows XP. SQ20A801
GSM-Modemsatz (Modem , Squirrel-Anschlusskabel), Stromversorgungskabel
und Antenne mit 3 m langem Kabel). Ihr Netzwerkbetreiber muss dartiber hinaus
eine nicht schreibgeschiitzte SIM-Karte bereitstellen. SQ20A802
WLAN-Adapter (RS232-Adapter zum drahtlosen Anbinden des Datenloggers
an einen PC bei Baudraten von bis zu 115 kBaud mit einem Wirkungsbereich von bis
zu 200 m auf dem 2,4 GHz-Frequenzband. Der Satz enthalt alle erforderlichen
Anschlusskabel.
Hinweis: Netzteile (MPU 12 V) mussen gesondert bestellt werden. SQ20A803
18108 Version 17 SQ2020/40
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Art.-Nr:
Auswechselbarer externer Speicher:
SD-Speicherkarte MMC64

Softwarepakete fiir Konfiguration, Dateniibertragung und Datenanalyse:
SquirrelView Plus
Vollstandige Datenanalyse, integrierte grafische Darstellung,

Messwerterfassung an Excel und Export in Excel SQA200
SquirrelView Plus Mehrbenutzerlizenz
Unbegrenzte Verwendung von SquirrelView innerhalb einer Organisation. SQA300

Kalibrierungszertifikate fiir die Squirrel 2020/40 Serie (alle Paletten)
Hinweis: Test- und Kalibrierzertifikate von Grant Instruments halten nationale

Normen ein.

SQ2020 CAL2020
SQ2040 CAL2040
Wetterfestes Gehause

Robustes wetterfestes Gehause aus Kunststoff PEL4
Wandhalterung

Montageblech aus Edelstahl fir Arbeitsplatz- oder Wandmontage WB6
Stromversorgung

100-240 V AC 50/60Hz mit dreipoligem Einzelstecker fir GrofR3britannien,

Europa und USA MPU 12V
MPU 12V, wird mit 1 m langem Flying Lead-Kabel geliefert MPU 12VFL
Wiederaufladbare Batterie (12 V, 6 Ah) SQ20RB12-6
Wiederaufladbare Batterie (12 V, 15 Ah) SQ20RB12-15

Digital-E/A-Schnittstellenanschluss
25-poliger D-Anschlussstecker, Miniaturldtanschluss mit Schirmung fir Digital-,

Alarm- und Pulseingadnge SB102
Stromnebenschlusswiderstande

Satz von 4 Préazisionswidersténden fir 4-20 mA-Analogeingange CS202
Kabel zum AnschlieBen von Datenloggern an Computer/Modems

Squirrel auf serielle PC-Schnittstelle LC71
Squirrel auf PC-USB-Schnittstelle LC77
Squirrel auf Modem LC73
Stromversorgungskabel 12 V DC

2,1 mm DC-Stecker verschweil3t mit 1,8 m-Kabel LC76
Anschlussleisten

Steckbare Anschlussleisten mit Kabelhalterung

3-polig 14174
4-polig 13975
6-polig 18097

Temperatur- und Luftfeuchtigkeitsfiihler

Grant bietet eine Palette an Temperatur- und Luftfeuchtigkeitsfiihlern an, die mit Grant Datenloggern
und anderen kompatiblen Messsystemen verwendet werden. Auf Wunsch sind auch
Spezialanfertigungen erhaltlich; bitte wenden Sie sich an uns, wenn Sie Spezialmessfiihler benétigen.

SQ2020/40 18108 Version 17
Seite 20
www.grantinstruments.com



9. Technische Daten

ANALOGEINGANGE
Basistoleranzbereich (5-45°C): ........................ + (0,05% Messwert +0,025% Messbereich)
GleichtaktunterdrlickUNg: .............ccoiiiiiiiii e 100 dB
Eingangsimpedanz: ............ ..>1MOHM
Linearitat: ... e 0.0015%
Serientaktunterdrickung: ... 50/60 Hz 100 dB
induzierte leitungsgefiihrte StorgroBen: ...............coccieiiiiiiini e <1% ¥
DIGITALEINGANGE
»0“-Eingangsspannung................ccccoeceeennnnn. 0 bis 0,5V (oder kurzgeschlossener Eingang)
»14-Eingangsspannung................cccccooiiieniienineenne 2,7 bis 5 V (oder Eingang im Leerlauf)
Eingangsschutzfunktion ............... wird bei Spannungen unter -0,5 V und Uber 6 V aktiviert
A/D-UMSETZER
1L/ < SR OPPR Delta-Sigma
Auflésung: .......

Abtastrate: ... bis zu 20/100 Messwerte pro Sekunde
Hinweis: 100Hz-Modus bei 1F8-Modellen nicht verfligbar

ALARMAUSGANGE ............c.coviveeeeeeeeeceeeeeeee e 4 Open Drain-FET (max. 18 /0,1 A)
SENSORSPEISUNG ............coocveiirine 5 VDC geregelt (50 mA) oder Betriebsspannung (100 mA)
UHRZEIT UND DATUM ... integrierte Uhr mit 3 Formaten
MESSWERTSKALIERUNG.............cccooiiiii e, Anzeige in Einheiten in technischen Einheiten
SPEICHER

Intern: ... 128 MB (bis zu 14.400.000 Messwerte pro Sekunde

EXxtern: ... 1 GB MMC/SD-Speicherkarte, auswechselbar
AUFLOSUNG .......ooooimiiiiiieiiic ettt bis zu 6-stellig
PROGRAMMIERUNGI/EINRICHTUNG
DES DATENLOGGERS ............ccccooeiiiiieee s SquirrelView oder SquirrelView Plus Software
KOMMUNIKATION.......cccoiiiiiiieceeee e USB 1.1 und 2.0 / RS232 / Ethernet (nicht 1F8)

Intern: ............. Wi-Fi

EXEOIN: e GSM, Ethernet und WLAN
STROMVERSORGUNG

INtEIN: oo 6 AA-Alkalibatterien

Extern: 10-18V DC, Sicherheitsabschaltung bei falscher Polaritat und Uberspannungsschutz

1 Dieser Effekt kann an 288kHz groRer sein, die Eingangskabel neuorientieren oder ein
verwendbares axiales Ferritkorn nah an der Datalogger wenn erforderlich hinzuftigen.

A * Die maximal zuldssige Betriebstemperatur fiir AA-Alkalibatterien betragt 50°C.
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STROMVERBRAUCH BEI 9 V
RUNEMOAUS: ... e e e e rre e e e e e senanes <600uA
Messwerterfassung: ...........cocoiiiiiiiiii e 40-120 mA

ABMESSUNGEN UND GEWICHT

Datenlogger 2020

ADMESSUNGEN: ......ooiiiiiiiiiiice e 235x 175 x55 mm (B x T x H)
Gewicht: .................

Gehausematerial: ...t ABS
Datenlogger 2040

ADMESSUNGEN: .......oiiiiiiiiiiiee e 235x175x92 mm (B x T x H)

SPEICHERMODI (nur intern)

DISPLAY UND TASTENFELD
LCD, 2 x 20 Zeichen

BETRIEBSTEMPERATUR ..o -30°C bis +65°C

Windows ist ein eingetragenes Warenzeichen der Microsoft
Corporation in den USA und anderen Landern.

Aufgrund kontinuierlicher Produktverbesserungen sind Anderungen der technischen Daten ohne

Vorankiindigung vorbehalten. @
Grant Instruments erklart, dass alle in diesem Dokument enthaltenen Informationen zum Zeitpunkt

der Drucklegung korrekt waren.

Fiir Fehler bzw. Auslassungen wird keine Haftung libernommen.
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1. Lista di controllo

R

Tuuy

Lt A
b

T

Registratore SQ2020/2040

Drive USB contenente il software (SQA100)

Manuale di guida al primo utilizzo (questo documento)

Cavo USB (LC77)

Staffa di montaggio/supporto del registratore (WB6)

Batterie, 6 x AA

Resistenze di derivazione (shunt) di corrente per ingressi da 4 a
20 mA, 10R x 4 (CS202)

Connettori: 6 vie x 4 (18097), 4 vie (13975), 3 vie (14174), con

fascette ferma-cavo d

Nota: |l registratore 2040 & fornito con 4 connettori a 6 vie
(18097) supplementari.
La versione Wi-fi comprende anche un’antenna.

LITDooB2

=z
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2. Informazioni generali

21 Installazione delle batterie

11 2020/2040 utilizza sei batterie alcaline formato AA inserite nell’apposito vano sotto
il coperchio amovibile. Per montare o sostituire le batterie:
1. Aprire il coperchio del vano batterie premendolo verso il basso e facendolo
scorrere come illustrato in figura.
2. Inserire sei batterie AA* rispettando la polarita.
3. Rimontare il coperchio del vano batterie

* Per la sostituzione si consiglia di utilizzare batterie di uguale marca, tipo e
condizione.

—

Importante: Rimuovere le batterie quando il logger rimane inutilizzato per lunghi
periodi di tempo o deve essere trasportato.

2.2 Indicatore di alimentazione

Indicatore di carica delle batterie
I Durante la registrazione, assicurarsi che il livello di carica delle batterie sia sufficiente
per portare a termine la registrazione. Per verificarlo, osservare l'indicatore di carica

delle batterie che appare nell’'angolo superiore destro del display.

LIVELLO DI CARICA LIVELLO DI CARICA
ALTO BASSO

Indicatore di alimentazione esterno
// Il registratore puo essere alimentato da una sorgente esterna (10-18 V DC)

Importante: per garantire la protezione dei dati in caso di improvvisa interruzione
della corrente, verificare che siano inserite le batterie quando I'unita & in funzione.
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3. Comunicazione con il registratore

3.1 Installazione del software

Per istruzioni dettagliate sull'installazione, consultare la ‘Guida di installazione del software’
fornita. Per I'installazione rapida, procedere come segue:

1. Verificare di disporre dei diritti di amministrazione per il PC sul quale si desidera
installare il software.

2. Verificare che tutte le applicazioni attive siano chiuse

3. Inserire 'unita USB nella porta USB del computer, aprire la finestra drive USB ed
eseguire il file .Programma exe.

4. Seguire la procedura guidata di installazione sullo schermo

Importante: verificare che sia installato il software prima di collegare il registratore di
dati Squirrel.

3.2 Collegamento del Registratore di dati Squirrel

Il collegamento al registratore pud essere effettuato con una delle seguenti modalita:

1. Seriale (RS232), con adattatori seriali
2. USB

3. Ethernet (se disponibile)

4. Wi-fi (se disponibile)

Vedere nel seguito per maggiori informazioni.

Seriale (RS232)

Per informazioni sull’'uso degli adattatori seriali, vedere il file Help (Guida) di SquirrelView.
Se si utilizza un cavo seriale diritto (RS232), collegare un’estremita del cavo alla porta
seriale del registratore e I'altra estremita del cavo alla porta seriale del PC. Una volta
effettuato il collegamento, si € pronti per attivare la comunicazione.
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uUsB
Collegare un’estremita del cavo USB al registratore e I'altra estremita del cavo USB al PC.

Una volta rilevato il registratore, il PC installa i driver dell'unita USB

Win 7/Vista - | driver dell'unita USB si installano automaticamente senza necessita di
ulteriori operazioni.

Win XP - | driver USB sono pre-installati e identificati automaticamente durante la
procedura guidata di installazione. Nella schermata ‘Found New Hardware

Wizard’ (Installazione guidata nuovo hardware), selezionare ‘No, not this time’ (No, non
ora) e in tutte le successive schermate selezionare ‘Next’ (Avanti) per portare a termine
l'installazione.

Found New Hardware Wizard Found New Hardware Wizard
Welcome to the Found New e
Hardware Wizard

Windows wil search for current and updated software by
Tooking on your computer, on the hardware installation CD. of on
the Windows Lipdate Web site (with your permission).

Fead ou privacy poliey

This wizard helps you install software for:

Grant Instruments 20xx USB Driver

(+)_ If your hardware came with an installation CD

Can Windows connect to Windows Lpdate to search for & or floppy disk. insert it now.

software?

O Yes, this time only
every time | connect a device

What do you want e wizardiada

Click Next to continue.

Click Next to continue.

Selezionare Continue Anyway (Continua comunque) quando appare I'avviso di
installazione hardware riferito al test del logo Windows. Una volta terminata I'installazione
dei driver, si & pronti per comunicare con il registratore di dati.

In caso di problemi, vedere Troubleshooting (Guida alla risoluzione dei guasti)->20xx USB
Drivers (Driver USB 20xx) nell’Help (Guida) di SquirrelView.
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Ethernet

Prima di utilizzare il collegamento Ethernet, leggere il manuale di configurazione disponibile
sotto ‘~\SquirrelView\Manuals\SQ20xx Inbuilt Ethernet Configuration.pdf’ dove
‘~\SquirrelView’ & la directory di installazione di SquirrelView. Collegare la propria rete
Ethernet alla porta Ethernet del registratore.

A Il collegamento Ethernet é disponibile solo quando il registratore é collegato a
un’alimentazione esterna.
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Wi-fi
Prima di utilizzare il collegamento Wi-fi, & necessario montare 'antenna sul registratore
come illustrato nel seguito.

1. Avvitare I'antenna nella presa filettata e orientarla nella stessa direzione
dell’antenna sul ricevitore collegato al PC (di solito verticale).

2. Collegare un’alimentazione esterna al registratore.

3. Quando si attiva I'alimentazione, le spie gialla e verde sul modulo iniziano a
lampeggiare. Il collegamento & stabilito quando la spia gialla rimane
permanentemente accesa.

Per completare I'installazione, consultare il manuale di configurazione disponibile sotto
‘~\SquirrelView\Manuals\SQ20xx Inbuilt Ethernet Configuration.pdf’ dove ‘~\SquirrelView’' &
la directory di installazione di SquirrelView.

Il collegamento Wi-fi & disponibile solo quando il registratore é collegato a
un’alimentazione esterna.
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4. Esempio per iniziare

Dopo l'installazione di SquirrelView, nella directory di installazione di SquirrelView &
installato un file di configurazione esemplificativo per la registrazione della temperatura
interna del registratore.

Tale file pud risultare utile per 'operatore inesperto che desideri prendere
dimestichezza con le funzioni del registratore.

41 Avvio di SquirrelView e selezione del tipo di registratore
Per lanciare SquirrelView, fare clic sull'icona di scelta rapida sul desktop o selezionare
il software dal menu di avvio. Dopo il caricamento di SquirrelView Assistant, occorre
selezionare il tipo di registratore e il metodo di comunicazione appropriati.

Il tipo di registratore € visualizzabile in SquirrelView Assistant. Per modificarlo,
selezionare Logger Selection (Selezione del registratore) dalla barra strumenti o
eseguire la procedura guidata di comunicazione (Communication Wizard). Nota: il
metodo di comunicazione predefinito & USB. Per utilizzare un altro metodo di
comunicazione, occorre selezionarlo tramite la procedura guidata di comunicazione
(Communication Wizard).

4.2 Sincronizzazione del registratore con il PC
E consigliabile iniziare sincronizzando I'orologio del registratore con I'orologio del PC.

| bt i o |

o Da SqUIrreIVIGW e Da”a SChermata Logger Control | Actions & Triggers Cont
Assistant, fare clic su Logger Setup e e
Logger Setup (Configurazione del Set Logger Time Manualy
registratore), Set Logger Time to PC Time
i H selezionare la scheda PC Time: 20/10/2003 15:30.08
: Logger Control Logger Date Fomat: | DD/MMAYY -
(Controllo del Logger Identficaton
Loager Setup registratore). Fare clic | ="
(This text is used to identify the logger)

su ‘Set Logger Time
to PC Time’ (Imposta
I'ora del registratore sull’'ora del PC) e fare clic su
OK nella schermata di conferma.
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4.3 Esecuzione della demo di avvio rapido (Quick Start Demo)

o In Squirrelview W SquirrelView Assistant
Assistant, fare clic su ‘Logger Grant SquirrelView:As:
Setup’ (Configurazione del OATA LOGGING
registratore) per accedere alla
schermata di configurazione del
registratore. Da qui, aprire il file
demo di configurazione
utilizzando File - > Open (Apri) e s

. s . Previous Files Dsed: (Double Click To Open)
selezionare il file appropriato per e
il proprio tipo di registratore. [ aroaram Fles U elview et S Lauick start, deme 178520

ci\program Fies|squirrelview|setfilesiauick start demo 2F5.520

Squirrel  Analysis Tools Logger Selection Help

= |\ & m| 4

Logger Setup  fDownloadData  Analysis Meter Mode  Logger Control - Communication
Wizard

Logger Type

2010

Remove Clear

@ Ora é visibile
la schermata =t Logger Setup (Quick Start Demo 1 F8) - For, 1F8 Loggers Q@@

Logger Setup File Squiel Wiew Options Help
(Configurazione || JZH 32 0 |BW M

del registratore) Sensor Type
dacuie T'g ot et Mot Set c Not Set
possibile £ |fpae 5ot Mot Set c Hiok Set
impostare le g Mok Set Mot Set C hiok Set
speciﬁche di 2 [Juot set Mot et c Hok Set
registrazione. J ot set ot et o ok Set
Mok Set Mot Set o Mok Set
Ne"a SCheda 1] Mot Set o Mot Set
Actual Channels ||£ — . —
i £i ot el ok Set
(?:::r?tl) Ref. Junction 1 Internal 9 Sample Inkerwal; A (00:00:01) Logging Inkerval: (00:00:01) Mode: Tnter
gcorrere ;,] ella High woltage 1 F Mot Set ]
High ¥oltage 2 F Mot Set
colonna Sensor c
Type (Tipo di ' ol
yp ( po Logger Control T Actions & Triggers T Configuration T DigitalfState T Alarms ]
sensore) fino a
: Logger Date | Time Logger Identification Memory Mode
Ref. Junction 1
(Giunto freddo 1) Set Logger Time Manualy | (':: N:W:Dggerdt sty thotoceny | Mode  [Stop when ful -
che rappresenta Set Lagger Time to PC Time et B e ey e et
i b i)
| qul'essol PiC Time: 24102006 12:50:14 [Quick Start Dema Delayed Start
izzato in (3) o
eSto €SemPpIO. || sensor power Tiers HEHD o
Job A (Supply) |on:00 3 [ Continuous B(5¥) |on:on i | [ Continuaus =|

Description & Communicaton |
(Descrizione

dell'operazione)
puo servire per
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@ Fare clic O Fare clic O Fare @ Fare clic

per inviare per clic per su Logger
la @ accedere a @ misurare Control q
’ l'ingresso (Controllo
in tempo del
configurazione al SquirrelView reale. registratore) per
registratore e Assistant. visualizzare lo stato
avviare la del registratore

registrazione.

O Nella finestra i Loggen Control X

Logger Control Squirrel View

(Controlio del Co Xl & % = 2

registratore) si

possono Lgfger Infarmation Mermory

V|sua|lzzare Varle SPJLDGQEI’ jin} Logger ID %%ﬂlnternal Memory Total 15616 KB

informazioni di / 3B} erial Mumber Ks0617012 Eflnternal Memory Used 14496 KB

n yijnggar Type 2F8 ﬁbﬂlnternal Memory Free 1120 KB

stato. gijoggar Stake Disarmed

Per arrestare la

registrazione, fare

clic sul pulsante di )
Date and Time Pawer Supply

arresto. =
[aBLogger Time 23/10/2006 12:37:03 B8 nternal supply 00y
:"ﬁ]Status Last Updated Z23/10/2006 14:358:49 ﬁlﬂExternal Supply 1z.ov
[aBPC Time FAFLOA006 1413849

© Per scaricare i dati di

registrazione, fare clic sull'icona

‘Download Data’ (Scarica i dati) da

SquirrelView Assistant. Download Daka
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! Download
Squirrel  View

Logger Data Files

04120547 04135524 04145536 04150726 05095550 14153917

Lagaer Data File Information

Data file 04120547

JDb Description fillup

3] arm Time 0407/2006 12:05:47
Disarm Tirne 04/07§2006 13:30:17
ab]File size 8.07 MB
Down\oaded Yes

14153923 04135950 04140004 04140019 05071157

Action After Download |Exp0rt Data j Advanced | Download Selected File(s)
Mo Ackion

Expart Data

® In questa schermata si pud ora scaricare il file di dati e richiamare la procedura

guidata di esportazione (Export Wizard) o scaricare il file di dati nella finestra Analysis*
(Analisi). Vedere la descrizione del processo di download.

Al file di dati & assegnato un nome esclusivo
(per esempio 28162735.D20). A destra & fornito 28162735 D20
( )

un esempio esplicativo del nome file che indica »
la data e I'ora di inizio TIME(24HR

Nell’esempio illustrato si scaricano e visualizzano i dati nella finestra Analysis* (Analisi).
Iniziare selezionando il file di dati e I'azione Graph Data (Rappresenta graficamente i
dati), quindi fare clic su Download Selected File(s) (Scarica il/i file selezionato/i). Sara
richiesto di salvare il file di dati prima di convertirlo per la visualizzazione.

B yow Gach ook b

@ Al termine della decodificazione, smuazme
] i« Ei 1o Quick Start Demo [
appare la finestra Analysis File s i
Description (Descrizione del file di A [ ! ‘ -
analisi): da qui, cliccando su OK, si 35 @ f ] | =
possono visualizzare i propri dati. e s | J f e
S il / i
sate | oo } - S
Analysis File Description =oilme. = = —tas
Enter a unique description for the new Analysis File m— e
[Quick Start Demo|
(o] oo
< > Sy | Waidad | s T Crvaiiio
*Disponibile solo in SquirrelView Plus.
18108 Versione 17 SQ2020/40
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5. Descrizione del processo di download

Registratore
File di dati L
— (.d20) Analisi
(.d20) File di analisi
(solo Plus)
y
’ File di dati :
SU | Lettore :
scheda di — . Esportazione
memoria
MMC/SD iyl
esterna SquirrelView

Valori separati da virgola

Nello schema qui sopra ¢ illustrato il processo di download. | dati nel registratore sono
conservati nella memoria interna e possono essere scaricati da SquirrelView.

Prima di visualizzare i dati, occorre convertirli con SquirrelView per I'analisi o esportarli in
formato .csv o .xlIs in funzione del software per PC utilizzato.

Il processo di conversione pud essere attuato in uno dei seguenti tre modi con SquirrelView:
— da SquirrelView Assistant - >Analysis (Analisi) ->Export Data File (Esporta file di dati)
— automaticamente con 'uso del pulsante Download Data (Scarica i dati) da SquirrelView*

— dalla schermata Logger Data Analysis (Analisi dei dati del registratore) selezionando il menu
File->Import Data (Importa dati)*

Una volta scaricato il file, si pud fare doppio clic per aprirlo con il programma specificato sotto
‘Tools’ (Strumenti), ‘Preferences’ (Preferenze), ‘File Association Action’ (Associazione file). ﬂ

*Disponibile solo in SquirrelView Plus.
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6. Menu e navigazione

6.1 Pannello di controllo
La figura seguente illustra in maggior dettaglio i comandi di navigazione.

NAVIGAZIONE
A DESTRA/VERSO IL
BASSO

NAVIGAZIONE
A SINISTRA/ VERSO
L’ALTO \
INVIO/CONFERMA E
ACCENSIONE
a @ USCITA/INDIETRO

(riporta al menu
precedente)

Per accedere al pannello di controllo del

2020/2040, premere €. --Main Menu------- a

Il timeout del display & preimpostato a IE' Ll}'d"r 1 E

10 secondi ma pud essere modificato dalla Tf
scheda Configuration (Configurazione)
della finestra Logger Setup Log Control
(Configurazione del registratore) di
SquirrelView.
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6.2 Menu del pannello di controllo
Nel seguito & fornita una descrizione generica della struttura del menu principale. Per
maggiori informazioni sull’intera struttura di menu, vedere Help (Guida)->Help Content
(Sommario)->Loggers (Registratori) all'interno di SquirrelView.

--Main Meruw-------
6.3.1 Log Control (Controllo del registratore) IE L’.E
In questo menu si pud attivare o disattivare [
il registratore. Tf
Log Control
6.3.2 Meter (Misura)
Da questo menu si pud visualizzare ciascun __Maim Mefu-------
canale in tempo reale (a 1-2 Hz). Utilizzare
il tasto di invio per ottenere una T . B D
rappresentazione grafica del canale. Tf
Meter
6.3.3 Status (Stato)
I menu Status (Stato) permette di accedere
a informazioni riguardanti il registratore, - '”‘3”" Menu-------
come la memoria disponibile e la tensione a v . @ D
di alimentazione. Da questo menu si D
possono anche disattivare le uscite di Tf
allarme. Status
6.3.4 Setup (Configurazione)
Que_sto menu comprende Ie_fun2|on| f:h = -Ham T P—
configurazione Language (Lingua), Time
(Ora) e Date (Data), oltre alle funzioni di iﬂ‘.{ . D
memorizzazione e richiamo delle D Tf
impostazioni e all’avvio ritardato.
: . . Setup
Vedere il punto 6.3 per maggiori dettagli
sulla configurazione di base
6.3.5 Data Files (File di dati) --fain fenu----- -
3. ata Files (File di dati ' .
Da questo menu & possibile copiare i file di " 11“-—-'5 1 E IE‘
dati su una scheda di memoria esterna (se D Tf
installata) e di cancellare i file di dati
presenti nella memoria del registratore. Data Files
6.3.6 Tools (Strumenti) --Maim Menu-------
I menu Tools (Strumenti) comprende ba =
funzioni di servizio come la verifica della D ! LE 1 @. E
versione software o dell'indirizzo IP del
registratore, I'esecuzione di un autotest e il Tool
ripristino del registratore. ool
SQ2020/40 18108 Versione 17
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6.3

Creazione di una configurazione di base

Il registratore 2020/2040 permette di creare una configurazione di base dei canali
impostando I'intervallo di registrazione, il tipo di sensore e il tempo di attivazione

(eccitazione) del sensore tramite interfaccia grafica. Una configurazione completa con

funzionalita piu avanzate pud essere creata utilizzando il software SquirrelView in

dotazione. Nel seguito & fornita una breve descrizione della configurazione di base di

un canale tramite interfaccia grafica.

--Betup----------- | |
6.3.1 Configurazione dei canali sensor Fouer
Da ‘Main Menu’ (Menu principale) scegliere ]
I'opzione ‘Setup’ (Configurazione) e quindi D;?Eﬁed-gggﬁ
I'opzione ‘Channel Setup’ (Configurazione dei DatesTime
canali). Configuration
6.3.2 Aggiunta o modifica di un canale --Channel Setup--- 0
Da ‘Channel Setup’ (Configurazione dei canali) Clear Channels
€ possibile aggiungere/modificare un canale, D 1ew Channe
visualizzare i dettagli di un canale o cancellare Delete Channhel
un canale. Selezionare ‘Add/Edit
Channel’ (Aggiungi/Modifica canale).
6.3.3 Aggiunta di un nuovo canale i@%’%‘?é—é] ------- L]
Il menu ‘Add/Edit Channel’ (Aggiungi/Modifica
canale) mostra i canali attualmente impostati e
permette di aggiungere altri canali. Selezionare
‘Add Channel’ (Aggiungi canale)
6.3.4 Configurazione dei canali c-Lhannel Setup--- @
Il menu Channel Setup (Configurazione dei ange
canali) contiene le opzioni Sensor Type (Tipo ) |5&nsor Power Timer
di sensore), Range (Campo) e Sensor Power
(Attivazione del sensore) per impostare il
tempo di attivazione/eccitazione del sensore .
6.3.5 Visualizzazione della configurazione dei canali e "
Una volta impostati i canali richiesti e i relativi et Junction
dettagli, € possibile visualizzare lo schema di D
cablaggio selezionando 'opzione ‘View
Channels’ (Visualizza canali).
Nota: in base al tipo di sensore per il canale U
selezionato, € visualizzata automaticamente la --Uiew Channel---- &
descrizione del canale che pud essere Ssnsor Powsr =
. . Mot U=zed
eventualmente modificata utilizzando Elock :A
SquirrelView. LEZEEH
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6.3.6

6.3.6

Configurazione dell’intervallo

La configurazione effettuata tramite il pannello

di controllo assegna a tutti i canali il medesimo
intervallo di registrazione. Per cambiare o
visualizzare l'intervallo, scegliere

‘Intervals’ (Intervalli) dal menu

‘Setup’ (Configurazione) principale.

Configurazione del tempo di attivazione del

sensore

Il tempo di attivazione del sensore & D
modificabile selezionando I'opzione ‘Sensor

Power’ (Attivazione del sensore) nel menu

‘Setup’ (Configurazione) principale.

--Intervals------- | |
12l

--Sensor Timer A-- &

Continuous

Wirimg

A Note importanti sulla configurazione tramite il pannello di controllo

L’'uso di SquirrelView permette di sfruttare tutte le potenzialita di configurazione del
registratore SQ2020/40. Per I'uso del pannello di controllo, occorre considerare alcuni
punti importanti:

A tutti i canali & assegnato il medesimo intervallo (Intervallo A). In caso di
configurazioni piu complesse, da SquirrelView, possono essere visualizzati tutti i canali

Per evitare problemi di cablaggio, non si pud madificare il tipo di sensore dopo
l'impostazione, mentre & possibile modificare il campo e il tempo di attivazione del
sensore. Occorre cancellare il canale se € necessario modificare il tipo di sensore

corrispondente

Se si supera il numero di sensori quando si aggiungono nuovi canali, compare il

messaggio "Setup invalido"

Con 'opzione di visualizzazione dei canali non & possibile visualizzare la

configurazione dei canali da SquirrelView

Il giunto freddo non puo essere eliminato durante la configurazione di un tipo di
sensore che necessita di tale giunto per funzionare in maniera corretta, per esempio

un sensore a termocoppia

Non si pud modificare una configurazione mentre € attivo il registratore

Il messaggio "Sub-Second rate" compare quando si tenta di visualizzare o modificare
Intervalli di campionamento che sono stati impostati a meno di 1 secondo. Utilizzare la
funzione Logger Setup (Configurazione del registratore) di Squirrelview per

visualizzare o modificare gli Intervalli

$Q2020/40
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7. Collegamenti

Ingressi analogici

= 7

12A45m 12C45m 1E3

Vista
posteriore
dei
connettori
ANALOGICI

12B45m 12D45m 12FA4

== =)

Morsettiera Morsettiera
G J

e
12G45m 1244 5m posteriore
12 H4 56 12 K45 dei
BOOOOE connettori
ANALOGICI

Morsettiera Morsettiera
H K

NOTA: Le morsettiere G a K sono disponibili
solo sui registratori 2040.

Lo schema di cablaggio dipende dal tipo di sensore utilizzato ed & visualizzabile in SquirrelView
durante la configurazione. Seguire lo schema di cablaggio per il collegamento del sensore richiesto.
Per stampare gli schemi o visualizzarli in un secondo momento, selezionare File > Print from Logger
Setup (Stampa dalla configurazione del registratore).

L’esempio che segue illustra il sensore a termocoppia differenziale K collegato al registratore 2020
secondo lo schema di cablaggio riportato a sinistra.

= Range Selection

&
Jew Range
Edit Rang
Add/Edit Scaling

Ranges available
PN -200 to 1372 °C
| 328 to 2501 °F

Voltage - Dif jal
Voltage - Single ended
Current

- Differental
-Single ended
-Single ended
- Single ended
) Thermocouple - Differential
KTh

[N Thermocauple - Differential
R Thermocouple - Differential
S Thermocouple - Differential |

The Reference Junction is required for logging of Thermocouples and will be set automatically

=1

Unsset chamel | Cancel
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Cablaggio di alimentazione sensori Ingresso alta tensione

T o

| 1

Se95

Uscita
alimentazione
registratore non
regolata

Negativo V1(+ve) V2(-ve)

Uscita regolata — V1(-ve) — — V2(+ve)
abVv /

.
T

Cablaggio ingressi

USCITA
PIN 1

2
5

Collegamento

1. Ingresso Evento/Stato 1
2. Ingresso Evento/Stato 2
3. Ingresso Evento/Stato 3
4. Ingresso Evento/Stato 4
5. Ingresso Evento/Stato 5
6. Ingresso Evento/Stato 6
7. Ingresso Evento/Stato 7
8. Ingresso Evento/Stato 8
|1 ] | 9. Massa
10. Uscita allarme A
1. Uscita allarme B
12. Uscita allarme C
13. Uscita allarme D
14. Uscita ausiliaria +ve
15. Uscita ausiliaria +ve
16. Uscita ausiliaria -ve
17. Uscita ausiliaria -ve
18. Massa
19. Massa
20. Massa
21. Ingresso Impulso veloce 1
22. Ingresso Impulso veloce 2
| INGRESS! IMPULSI | |\NGRESS\ IMPULSI| 1 23. Ingresso Impulso lento 1
LENTI1-2 VELOGI 12 = 24. Ingresso Impulso lento 2
25. Nessun collegamento

Lettore di schede di memoria esterne

Lo slot per schede SD esterne si trova all'interno del
vano batterie.
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8. Accessori

Grant Instruments fornisce una vasta gamma di accessori abbinabili ai registratori di dati Squirrel,
inclusi i seguenti adattatori che permettono di comunicare con il registratore di dati a distanza.
Tutti gli accessori sono estremamente facili da installare e si collegano direttamente al registratore
tramite interfaccia RS232. Per ricevere maggiori informazioni o effettuare un acquisto, contattare
Grant Instruments o il proprio rivenditore locale.

GSM
Wireless

Model No: AMC232LANO1 =

I CE ===51

Codice articolo:
Convertitore da RS232 a Ethernet con modulo adattatore e cavo per modem.
Il software di configurazione Ethernet & compatibile esclusivamente
con Windows 2000 e XP. SQ20A801

Kit modem GSM comprensivo di modem, cavo di collegamento a Squirrel,
cavo di alimentazione e antenna con cavo di 3 m. E necessaria anche una scheda
SIM abilitata al traffico dati da richiedere al proprio fornitore di servizi di rete. SQ20A802

Adattatore wireless comprensivo di adattatore RS232 per il collegamento

del registratore al PC a velocita di trasmissione (baud rate) fino a 115 K2 con un
raggio di copertura fino a 200 metri nella banda di frequenza 2,4 GHz. Il kit & fornito
con tutti i cavi di collegamento.

Nota: gli alimentatori (MPU 12 V) vanno ordinati separatamente SQ20A803
18108 Versione 17 SQ2020/40
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Codice articolo:
Memoria esterna rimovibile a richiesta
Scheda di memoria SD. MMC64

Pacchetti software di configurazione, trasferimento e analisi dei dati:

SquirrelView Plus

Permette I'analisi completa dei dati, la rappresentazione grafica online,

la misura su Excel e I'esportazione in Excel SQA200
SquirrelView Plus Multi-User License

Licenza multi-utente per I'uso illimitato di SquirrelView nell’ambito di

un’organizzazione. SQA300

Certificati di taratura per tutti i registratori serie Squirrel 2020/40
Nota: | certificati di prova e taratura forniti da Grant Instruments sono rintracciabili
nelle norme nazionali

S$Q2020 CAL2020
SQ2040 CAL2040
Contenitore resistente agli agenti atmosferici

Robusto contenitore in plastica resistente agli agenti atmosferici PEL4

Staffa per montaggio a parete

Staffa in acciaio inox per montaggio a tavolo o a parete WB6
Alimentatori

100-240 V AC 50/60 Hz con spine di rete universali (UK, EUR, US) MPU 12V
Come MPU 12V ma con cavo libero da 1 MPU 12VFL
Batteria ricaricabile (12 V, 6 Ah) SQ20RB12-6
Batteria ricaricabile (12 V, 15 Ah) SQ20RB12-15

Connettore d'interfaccia 1/O digitale
Collegamento a saldare con connettore D-subminiatura a 25 vie con calotta

per ingressi digitali, ingressi di allarme e impulsi SB102
Derivazioni (shunt) di corrente

Serie di 4 resistenze di precisione per canali analogici da 4 a 20 mA CS202
Cavi di collegamento tra registratori di dati e computer/modem.

Da Squirrel a porta seriale di PC LC71
Da Squirrel a porta USB di LC77
Da Squirrel a modem LC73

Cavo di alimentazione 12V DC
Connettore di alimentazione DC 2,1 mm con fusibile e cavo da 1,8 m LC76

Morsettiere
Morsettiere estraibili con ferma-cavi

3 vie 14174
4 vie 13975
6 vie 18097

Sonde di temperatura e umidita

Grant offre una gamma di sonde di temperatura e umidita utilizzabili con i propri registratori di dati e
altri sistemi di misura compatibili. Sono disponibili anche sonde speciali o realizzate appositamente.
Non esitate a contattarci per richieste specifiche sulle sonde.

SQ2020/40 18108 Versione 17
Pagina 20
www.grantinstruments.com



9. Specifiche tecniche

INGRESSI ANALOGICI
Precisione di base (5-45 °C): ..........cccceiiiiiiinns + (0,05% di lettura + 0,025% di intervallo)
Reiezione in Modo COMUNE: .............ocoiiiiiiiiii e 100dB
Impedenza di ingresso: ......... ....>1 MOHM
Lin@arita: ... s 0,0015%
Reiezione di linea in modo serie: ... 50/60 Hz 100 dB
Effetto di campi EM ed emissioni RF condotte: ..................coccooiiiiiiiiniis <1% T

INGRESSI DIGITALI

Tensione di iNGresSs0o Zero.............ccceeiiiiiiiiiiic i da 0 a 0,5V (cortocircuito)

Tensione di iINGresso UNO.............cccooooiiiiiiiiiiieiee s da 2,7 a 5 V (circuito aperto)

Protezione di ingresso.................. si attiva al disotto di -0,5 V circa e al disopra di 6 V circa
CONVERSIONE ANALOGICO-DIGITALE

LI <1 TSP OTPR Sigma-Delta

RISOIUZIONE: ... e e 24 bit

Frequenza di campionamento: ...............................l Fino a 20/100 letture al secondo

Nota: la modalita 100 Hz non & disponibile sui modelli 1F8

USCITEDIALLARME ............oooiiiieeeeee e 4 x FET open-drain (18 V 0,1 A max)
ALIMENTAZIONE SENSORI......... Tensione di alimentazione (100 mA) o regolata a 5V DC (50mA)
DATA E ORA .ottt e ettt e et e e Orologio in 3 formati
MESSA IN SCALA DEI DATI .................. Visualizzazione delle letture nelle unita tecniche prescelte
MEMORIA
Interna: ... 128 Mb (Fino a 14 400 000 letture)
Esterna: ..o Scheda di memoria MMC/SD rimovibile fino a 1Gb
RISOLUZIONE ... Fino a 6 cifre significative
PROGRAMMAZIONE/CONFIGURAZIONE
DEL REGISTRATORE ..........ccccovvviiieeeieeee e Software SquirrelView o SquirrelView Plus
COMUNICAZIONE ..........coooiiiiiiiieiieeeeee e USB 1.1 e 2.0/ RS232 / Ethernet (non 1F8)
Interna opzionale: ..... Wifi
Esterna opzionale: .............cccooiiiiiiiiiiii s GSM, Ethernet e wireless
ALIMENTAZIONE
INEEINAL ..o e 6* x batterie alcaline AA
Esterna: ........................... 10-18 V DC, con protezione da polarita inversa e sovratensione

1 Questo effetto pud essere piu grande a 288kHz, orientare di nuovo i cavi dell'input o  aggi-
ungere un branello di ferrite assiale adatto vicino al registratore a richiesta

f * La massima temperatura di esercizio per le batterie alcaline in dotazione & 50 °C

18108 Versione 17 SQ2020/40
Pagina 21
www.grantinstruments.com



CONSUMO a 9V
Modalita di attesa (Sleep Mode): ............ccoiiiiiiiiiiiii e <600 pA
RegiStrazione: ...........cccoiiiiiiiii e 40-120 mA

DIMENSIONI E PESO

Registratore 2020
DIiMENSIONI: .....ooiiiiiii e L 235 xP 175 x A 55 mm
PeSO: ... Circa 1,2 kg
Materiale del contenitore esterno: .............cccoooiiiiiiii e ABS
Registratore 2040
DIiMENSIONI: .....oeiiiiiii e L 235xP 175 x A 92 mm
P BSO: .. ettt be e e e Circa 1,5 kg
Materiale del contenitore esterno: .............ccccccoiiiiiiiiiiin ABS
MODALITA’ DI MEMORIA (solo interna) ............. Arresto o sovrascrittura al completamento della memoria
DISPLAY E TASTIERA
Display LCD a 2 linee x 20 caratteri
AMBIENTE OPERATIVO ... da -30 °C a +65 °C

Windows €& un marchio registrato di Microsoft Corporation
negli Stati Uniti e in altri paesi.

In linea con la nostra politica di miglioramento continuo, ci riserviamo il diritto di apportare
modifiche alle caratteristiche senza obbligo di preavviso.

Grant ritiene che tutte le informazioni qui contenute fossero corrette al momento della stampa e
non si assume alcuna responsabilita per eventuali errori od omissioni.
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1. Lista de comprobacion

Registrador SQ2020/2040

Unidad USB con software (SQA100)

Manual de Puesta en Marcha (este folleto)

Cable USB (LC77)

Soporte de montaje/base del registrador (WB6)

6 pilas AA

Resistores de derivacion de corriente para entradas de 4 a

20 mA, 4 de 10R (CS202)

Conectores: 4 de 6 vias (18097), 4 vias (13975), 3 vias (14174),
con enlaces de cables

LITDooB2

=z

Nota: El registrador 2040 se entrega con 4 conectores de 6 vias
adicionales como se muestra arriba (18097).
La versién Wi-Fi incluye también una antena.
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2. Informacion general

21 Colocacion de las pilas

Los modelos 2020/2040 utilizan seis pilas AA alcalinas colocadas bajo una tapa
extraible, como se muestra mas abajo. Para introducir pilas nuevas o cambiarlas:
1. Abra la tapa presionando y desplazandola en el sentido de las flechas de
la ilustracion.
2. Introduzca las seis pilas AA* con la polaridad correcta.
3. Coloque la tapa de nuevo.

* Se recomienda que todas las pilas de repuesto sean del mismo fabricante, tipo y
condicion.

Importante: extraiga las pilas del registrador cuando no lo vaya a utilizar durante
un largo periodo de tiempo y para transportarlo.

2.2 Indicador de alimentacion

Indicador de pila

Para realizar registros, asegurese de que las pilas de la unidad tienen suficiente
capacidad para finalizar la tarea, lo que se puede comprobar mediante el indicador de
carga de las pilas situado en el angulo superior derecho de la pantalla.

ALTA BAJA
CAPACIDAD CAPACIDAD

// Indicador de alimentacion externa
El registrador puede alimentarse con una fuente externa (10-18 V de CC)

Importante: Para garantizar la proteccién de los datos en caso de corte de
corriente imprevisto, asegurese de que las pilas estan colocadas siempre que la
unidad vaya a utilizarse.
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3. Comunicacion con el registrador

3.1 Instalacion del software

Para obtener informacién mas detallada sobre la instalacion, consulte el suplemento
‘Software Installation Guide’ suministrado. Para una instalacién rapida, siga los pasos
siguientes:

1. Asegurese de tener derechos de administracion en el PC donde desea instalar el
software.

2. Asegurese de cerrar todas las aplicaciones Grant que tenga abiertas.

3. Introduzca el unidad USB al puerto USB de su ordenador, abra la ventana de las
unidad USB y ejecutar el programa exe.

4. Siga las instrucciones del asistente de instalacién en pantalla.

Importante: Antes de conectar el registrador de datos Squirrel, asegurese de que el
software esta instalado.

3.2 Conexion del registrador de datos Squirrel

Puede conectar con el registrador mediante uno de los siguientes métodos:

1. Serie (RS232), incluidos adaptadores serie
2. USB

3. Ethernet (cuando esté instalado)

4. Wi-Fi (cuando esté instalado)

Consulte la informacién que se incluye a continuacion.

Serie (RS232)
Para obtener informacion sobre cémo utilizar adaptadores serie, consulte la Ayuda de Squi-
rrelView. Si emplea un cable serie recto (RS232), conecte un extremo al puerto serie del

registrador y el otro al puerto serie del PC. Una vez conectado, ya puede comenzar la
transmisién de datos.
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usB

Conecte un extremo del cable USB suministrado al registrador y el otro al PC.

Tras detectar el registrador, el PC instalara los controladores del dispositivo USB

Win 7/Vista - Los controladores del dispositivo USB se instalan automaticamente, sin ne-

cesidad de intervenir.

Win XP - Los controladores USB se instalaron durante la instalacion, por lo que el asisten-
te localizara el controlador de forma automatica. En el ‘Asistente para hardware nuevo
encontrado’ seleccione ‘No por el momento’ y en todas las demas pantallas seleccione

‘Siguiente’ para finalizar la instalacién.

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

Windows wil search for current and updated software by
looking on your computer, on the haidware installation CD, of on
the Windows Update Web site (with your permission).

Read ou privacy policy

Can Windows connect to Windows Update to search for
software?

O Yes, this time only
nd every time | connect a device

Click Next to continue.

FoundNew Hardware Wizard

This wizard helps you install software for

Grant Instruments 20x: USB Driver

() 1f your hardware came with an installation CD
&2 or floppy disk, insert it now.

What do you wantthe, 2

O install the software automalicaly (ecommended]
O .

Click Next to continue.

Seleccione Continuar cuando durante la instalacion del hardware aparezca el mensaje
relativo a la prueba del logotipo de Windows. Una vez finalizada la instalacion del
controlador, ya puede comunicarse con el registrador.

En caso de surgir cualquier problema, consulte lo relativo a solucién de problemas,
Troubleshooting->20xx USB Drivers, en la Ayuda de SquirrelView.
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Ethernet

Antes de utilizar la conexion Ethernet, lea el manual de configuracion que se encuentra en
‘~\SquirrelView\Manuals\SQ20xx Inbuilt Ethernet Configuration.pdf’, donde ‘~\SquirrelView’
es el directorio de instalacion de SquirrelView. Conecte la red Ethernet al puerto Ethernet
del registrador.

A Ethernet sélo esta disponible cuando el registrador esta conectado a una fuente de
alimentacién externa.
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Wi-Fi
Antes de utilizar la conexion Wi-Fi es necesario montar la antena en el registrador como se
muestra a continuacion..

1. Enrosque la antena en la toma roscada y oriéntela en la misma direccion que la
de la antena del receptor conectada al PC (normalmente en vertical).

2. Conecte al registrador una fuente de alimentacién externa.

3. Al encender, los pilotos amarillo y verde del médulo parpadean. Cuando el piloto
amarillo permanece encendido significa que la conexidn esta establecida.

Para finalizar la instalacion, consulte el manual de configuracion en
‘~\SquirrelView\Manuals\SQ20xx Inbuilt Ethernet Configuration.pdf’, donde ‘~\SquirrelView’
es el directorio de instalacién de SquirrelView.

Wi-Fi solo esta disponible cuando el registrador esta conectado a una fuente de
alimentacién externa.
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4. Ejemplo de inicio rapido

Una vez instalado SquirrelView, se instala un archivo de configuracién de ejemplo en
el directorio de instalacion de SquirrelView. El archivo de ejemplo registrara la
temperatura interna del registrador.

Esta configuracion de ejemplo puede ser util para que el usuario principiante se
familiarice con el registrador.

4.1 Inicio de SquirrelView y seleccion de registrador (Logger Type)
Haga clic en el icono de acceso directo del escritorio para abrir SquirrelView o
seleccionelo en el menu Inicio. Una vez cargado el Asistente de SquirrelView,
asegurese de seleccionar el tipo de registrador y el método de comunicacion
correctos.

El tipo de registrador se puede ver en SquirrelView Assistant. Si necesita realizar
cambios, seleccione Logger Selection en la barra de herramientas o ejecute el
Asistente de comunicacion (Communication Wizard). (Nota: el método de
comunicacioén predeterminado es USB por lo que, si esta utilizando otro de los
métodos de comunicacion, tendra que cambiarlo en Communication Wizard).

4.2 Sincronizar registrador y PC

© En Squirrel- ® En la pantalla Log- —— A
View Assistant, ger Setup, seleccione |
haga clic en la pestafna Logger Set Logger Time Manuoly
Logger Se- Control. Haga clic en & SetLogger Time oPC Tine EL
tup. o Il ‘Set Logger Time to PCTime:  20/10/20031530.08
PC Time’ y, a conti- Logger Date Fomat:  [DD/MMAYY -
nuacion, en la panta- U
Logger Setup lla de confirmacion, Loooer 0 ,
(This text is used to identify the logger)

haga clic en OK.
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4.3 Ejecucion del inicio rapido de muestra

O En SquirreIView W SquirrelView Assistant
Assistant, haga clic en ‘Logger Grant SquirrelView-Ass|
Setup’ para abrir la pantalla de SATA-LOGGING

configuracion del registrador

Squirrel  Analysis Tools Logger Selection Help

Logger Sgtup. Des_de aqui se = @ = S —
puede abrir el archivo de datos - b & (%)
de muestra con la seleccion de Logger Setup  fDownload Data Analysis Meter Mode  Logger Control  Communication 2010
Wizard
File -> Open y el archivo apro- s
. . . Previous Files Dsed: (Double Click To Open)
piado para el tipo de registrador e
S LB e e ook At o e 250
Browse.....
Remove Clear
® La pantalla
Logger Setup £ Logger Setup, (Quick Start Demo 1FE) - For 1F8 Loggers fEx

se abre para File Squirrel Wiew Options Help
poder configu- | A= 4 1 SRB B

rar las necesi- || . vpe
dades de regis- 'g Mok Set Mot Set C Hok St
tro g Mot Set Mot Set = Mot Set
g Mot Set Mot Set C Mot Set
=
En Ia ﬁCha é Mok Set Mot Set C Mok Set
ACtUa| Chan‘ J Mot Set Mot Set o Mot Set
ne|S deSp|éce- Mot Set Mot Set o Mot Set
1 H H Mot Set o Mok Set
se hacia abajo || g
r I I mn E Mot Set o Mok Set
go g cc_)ru & i|Reference Junction ;50 t0150'C Ref. Junction 1 Internal 9 Sample Inkerval: A (00:00:01) Logging Interval: {00:00:01) Mode: Inter
h entso'; %’pe High Yoltage 1 F Mot Set
J a8 at © 1 Highvolkagez  F Mok Set
unction 1. | = lL
Se trata de la Logger Control T Actions & Triggers T Configuration T DigitalfState T Alarms ]
entrada cuya X Logger Dake [ Time Logger Tdentfication Memory Mode
|eCt’U i 53 H2E(T- Set Logger Time Manualy | i tew Logaer Memory Mode | Stop when Full 2
zara en este (This text is used ta identify the logger)
ejemplo. Set Logger Time to PC Time
105 Bron
PC Time: 24/10{2006 12:50:14 W Delayed Start
© E| campo " trable 2
Job Descr|pt|on Sensor Power Timers
puede utilizarse A(supply) [o0:00: = [ Continuous 8 (¥ [oos00 T =) [ Continuous =

para describir la | @ communication |
configuracion.
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0 Haga © Haga @ Haga @ Haga clic

clic para clic para clic si en Logger

enviar la % abrir Squi- ﬂ desea Control q
configura- | # rrelView medir la para ver el

cion al Assistant. entrada estado del
registrador y comen- en tiempo real. registrador.

zar el registro. Deje
que la unidad regis-
tre durante unos
minutos.

i Loggen Control E]

O La ventana

Logger Control Sapiie Wiz

permite visualizar r b | = % =] @

diversa informa-

cién sobre eI fAger Information Mermory

estado. gﬁ'jLogger j(n] Logger ID ﬁbﬂlnternal Memary Total 15616 KB
2B Serial Number KS0617012 B8Internal Memary Used 14496 KB
yijnggar Type 2F8 ﬁbﬂlnternal Memory Free 1120 KB

Para detener el gijoggar State Disarmed

registro, haga clic
en el botén de

parada.
Date and Time Pawer Supply
[aBLogger Time 23/10/2006 12:37:03 B8 nternal supply 00y
:"ﬁ]Status Last Updated Z23/10/2006 14:358:49 ﬁlﬂExternal Supply 1z.ov
[aBPC Time 23(10/2006 14:36:49
© Para descargar los datos del
registrador, haga clic en el icono
‘Download Data’ de SquirrelView
Assistant. Download Daka
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! Download
Squirrel  View

Logger Data Files

04120547 04135524 04145536 04150726 05095550 14153917

Lagaer Data File Information

Data file 04120547

JDb Description fillup

3] arm Time 0407/2006 12:05:47
Disarm Tirne 04/07§2006 13:30:17
ab]File size 8.07 MB
Down\oaded Yes

14153923 04135950 04140004 04140019 05071157

Action After Download |Exp0rt Data j Advanced | Download Selected File(s)
Mo Ackion

Expart Data

OEsta pantalla permite descargar el archivo de datos y abrir el Asistente de exporta-

cion (Export Wizard) o descargar dicho archivo en Analysis* (consulte el apartado 5,
Proceso de descarga).

Al archivo de datos se le asigna un nombre exclu- 28162755/.020
(24HR)

sivo (p. €j., 28162735.D20). La explicacion del

nombre del archivo se incluye en la ilustracion de TIME(24HR
la derecha, donde se muestra la fecha y la hora
de inicio.

En este ejemplo se descargaran y visualizaran los datos en la ventana Analysis*. Para
comenzar, seleccione el archivo de datos y la accién de representacién grafica de
datos y, a continuacion, haga clic en Download Selected File(s). El sistema solicitara
guardar el archivo de datos. A continuacién, los datos se convertiran para visualizarlos.

B yow Gach ook b

® Una vez finalizada la descodificacion, |om««zms=

: . e Quick Start Demo oG
se abre la ventana Analysis File |mm —
Description. Haga clic en OK para Er A ! \ -
visualizar los datos. e = f / | =

3z o — | =
S Bl / -
st o } ] e
Analysis File Description all s = = —tae
Enter a unique description for the new Analysis File m— e
[Quick Start Demo|
[ ] o |
*Disponible solo con SquirrelView Plus.
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5. Proceso de descarga

Registrador

Archivos L
de datos
P (d20) Analisis
(.d20) Archivo de
analisis
(s6lo Plus)
y
/ Archivo .
de datos | | actor vt
&l — - Exportacién
tarjeta
MMC/SD p
externa SquirrelView

Valores separados por
comas

El diagrama anterior muestra el proceso de descarga. Los datos que contiene el registrador se
graban en la memoria interna y se pueden descargar mediante SquirrelView.

Antes de poder visualizar los datos, SquirrelView los debe convertir para andlisis o exportar en
formato .csv o .xls, dependiendo del software del PC en uso.

El proceso de conversion se puede realizar en SquirrelView con una de las siguientes opciones:
— desde SquirrelView Assistant->Analysis->Export Data File

— de forma automatica mediante el boton de descarga de datos deSquirrelView*

— desde la pantalla Logger Data Analysis, seleccionando el menu File->Import Data*

Una vez descargado el archivo, se abre con un doble clic después de seleccionar ‘Tools’,
‘Preferences’, ‘File Association Action’.

*Disponible solo con SquirrelView Plus.
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6. Menu y desplazamiento

6.1 Panel de control

En la ilustracién siguiente se muestran los mandos de desplazamiento con mas detalle.

DENTE

DESPLAZAMIENTO
ALA
IZQUIERDA/ ASCEN- \

Para utilizar el panel de control de los
modelos 2020/2040 pulse @ .

El tiempo de espera de la pantalla esta
predefinido en 10 segundos, pero este
valor puede modificarse en la ficha
Configuration de la ventana Logger Setup
de SquirrelView.

DESPLAZAMIENTO
A LA DERECHA/HACIA
ABAJO

INTRO/CONFIRMAR

y
ENCENDIDO

ESCAPE/ATRAS
(recupera el menu
anterior)

e ¢ D

--Main Heru------- [ |

Pl by i BY B
1}

Log Conmtrol
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6.2 Menu del panel de control
A continuacion se incluye una descripcion basica de la estructura del menu principal.
Para obtener mas informacion sobre la estructura de menus completa, consulte el conte-
nido de la Ayuda del programa SquirrelView (Help->Help Content->Loggers).

--Main Menu------- | |
6.2.1 Log Control IE lns
En este menu se puede activar (Arm) o D
desactivar (Disarm) el registrador. Tf
Log Control
6.2.2 Meter - Maim Mehd-------
Permite ver cada canal en tiempo real
(a 1-2 Hz). Utilice el botoén Intro para T . B D
mostrar una vista grafica del canal Tf
apropiado.
Meter
6.2.3 Status
El menu Status permite acceder a - '”‘-"1” Menu-------
informacion relacionada con el registrador, a v . i| B D‘
como la memoria y la tensién de la fuente D
de alimentacién. En este menu también es Tf
posible anular las salidas de alarma. Status
624 (S)?Jtan[ipene menus de ajuste de idioma, hora ) -Ham Mlenu--- -
fecha, configuracién basica de canales, iﬂ‘.{ . D
almacenamiento y recuperacion de D Tf
configuraciones e inicio aplazado.
Setup
Para obtener mas detalles sobre la
configuracion basica, consulte el apartado
6.3. --Main Menu------- | |
by =
6.2.5 Data Files e i B E
Este menu permite copiar archivos de datos Tf
en una tarjeta de memoria externa (si esta Data Fil
acoplada) y borrar archivos de datos de la ata 71 es
memoria del registrador.
6.26 Tools --Main Menu------- | |
El menu Tools contiene funciones de e 1B
mantenimiento como consultar la version (=]
del software o la direccion IP del
registrador, realizar una autocomprobacién Tools
y restablecer el registrador. .
ES
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6.3

Creacion de una configuracion basica

El modelo 2020/2040 permite crear una configuracion basica de canales, lo que inclu-
ye intervalo de registro, tipo de sensor y alimentacion de sensor (excitacion) si es pre-
ciso a través de la interfaz grafica. Se puede realizar una configuracién completa con
mas funciones avanzadas mediante el software SquirrelView que se incluye. A conti-
nuacion se incluye una breve explicacion de como crear una configuracion basica de
canales mediante la interfaz grafica.

--Setup----------- | |
6.3.1 Configuracién de canales %ﬁ@ggaaﬁ'gwer
En el ‘menu principal’ elija la opcion ‘Setup’y, B> |[i
a continuacion, ‘Channel Setup’. D;?Eﬁed-ggﬁ
DatesTime
Configuration
6.3.2 Adiciéon o modificaciéon de canales --Channel Setup--- &
Una vez en ‘Channel Setup’, puede eliminar Clear Chahmels
todos los canales, agregar o modificar un ca- D TEL aRRE
nal, ver detalles de canales o suprimir un ca- Delete Channel
nal. Seleccione ‘Add/Edit Channel'.
6.3.3 Adicién de nuevo canal ot o Lyl .
El menu ‘Add/Edit Channel’ muestra los cana-
les actualmente fijados y permite agregar
otros. Seleccione ‘Add Channel'.
6.3.4 Configuracién de canales cobhannel Setup--- @
Seleccione el tipo de sensor de canal, el mar- arnae
geny, si es preciso, el tempo de alimentacion ) [Fensor FPower Timer
del sensor (excitacion) que debe utilizarse.
6.3.5 Visualizacion de configuracién de canales --lliew Chfhhel ----
Una vez finalizada la inclusion de los canales UG 1o
y detalles necesarios, se puede ver la configu- D
racién de las conexiones mediante la opcién
‘View Channels’.
Tenga en cuenta que la descripcion del canal U
se asigna de forma automatica segun el tipo -
de sensor del canal, aunque en caso preciso fooiew Channel---- A8
puede modificarse mediante SquirrelView. éi‘{-:ész!SnE'd
i1 £ = 2 & &
R e o g e |
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6.3.6  Configuracion de intervalos --Intervals------- [
Las configuraciones creadas desde el panel de T
control asignan a todos los canales el mismo D
intervalo de registro. Para modificar o ver este
intervalo, elija ‘Intervals’ en el menu principal
de configuracion ‘Setup’.
6.3.6 Configuracién de alimentacion de sensores --Sensor Timer H-- &
La configuracion de la alimentacion de los
sensores se puede modificar en ‘Sensor D Continuous
Power’, opcion a la que se accede desde el Wirimg
menu principal de configuracion ‘Setup’.

A Notas importantes sobre la configuracion mediante el panel de control

El software SquirrelView proporciona todas las posibilidades de configuracion del mode-
lo SQ2020/2040. Cuando utilice el panel de control, tenga presentes los siguientes pun-
tos importantes:

° Aunque a todos los canales se les asigna el mismo intervalo, Interval A, todos los in-
tervalos se pueden visualizar en SquirrelView cuando se precise una configuraciéon
mas compleja.

° Para evitar problemas con la configuracion de las conexiones, el tipo de los sensores
no es modificable una vez ajustado, aunque si es posible cambiar los requisitos de
alimentaciéon y margen. Si necesita cambiar un tipo de sensor, elimine éste.

. La configuracién de canales ajustada desde SquirrelView no se puede visualizar en la
opcion de visualizar canales.

° Cuando al afadir canales se supera el numero de sensores, aparece el mensaje
"Config no valida".

. La conexion de referencia (Reference Junction) no se puede borrar cuando se instale
un tipo de sensor que la requiera para funcionar de forma correcta (como, por ejemplo,
un termopar).

° Las configuraciones no se pueden modificar con el registrador activado.

. El mensaje "Frec. Monor segundo" aparece al intentar ver o modificar intervalos de
muestra establecidos en menos de 1 segundo. Utilice Squirrelview Logger Setup para
ver o modificar los intervalos.

SQ2020/40 18108 Versione 17
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7. Conexiones

Entradas analégicas

BLOQUE BLOQUE BLOQUE
A C E
| |

12A45m 12C45m 1E3

Vista poste-
rior de co-

nectores
12B45m 12D45m 12F 4

ANALOGI-
e ] AW

BLOQUE BLOQUE BLOQUE
B D F

BLOQUE BLOQUE
G J

12G45m 12J 4 5m

12 H45m 12 K4 5m

BLOQUE BLOQUE
H K

Vista poste-
rior de co-
nectores
ANALOGI-
COS

NOTA: Los bloques G y K que se muestran

arriba solo estan disponibles en los

registradores 2040.

Como la configuracion de conexiones depende del tipo de sensor utilizado, se muestra en
SquirrelView durante la configuracion. Aplique el diagrama de conexiones para conectar el sensor
requerido. En caso de desear imprimir los diagramas con mas detalle o bien verlos mas adelante,

seleccione ‘File > Print from Logger Setup’.

En el ejemplo siguiente se muestra el sensor termopar diferencial de tipo K real conectado al
registrador 2020 a partir del diagrama de conexiones de la izquierda.

= Range Selection X
Sensor Type Ranges available
Pl -200 to 1372 °C RS
| 328 to 2501 °F -
Add/Edit Scaling

Voltage - Dif jal
Voltage - Single ended
Current

D Thermocouple - Differental
5 Thermocouple - Single ended
C Thermacouple - Single ended

D Thermacouple - Single ended

) Thermocouple - Differential

KThermocouple - Differential

[N Thermocouple - Differential

R Thermocouse - Dfferenta

S Thermocouple - Differential ]
The Reference Junction is required for logging of Thermocouples and will be set automatically

Unsset chamel | oK Cancel
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Conexiones de alimentacion de sensor Entrada de alta tension

Blogue E
o ]

| 1
Salida de SO
alimentacion no
regulada de .
. + -
registrador Negativo V1(carga+) V2(carga-)
@] [O] L« b
Salida regulada — V1(carga-) e V2(carga+)
de5V () / N
- “ J
Conexiones de conector de E/S
Pin Conexion
ALARMA
PIN 1 1. Entrada 1 Suceso/Estado
2. Entrada 2 Suceso/Estado
3. Entrada 3 Suceso/Estado
4. Entrada 4 Suceso/Estado
5. Entrada 5 Suceso/Estado
6. Entrada 6 Suceso/Estado
7. Entrada 7 Suceso/Estado
8. Entrada 8 Suceso/Estado
|1 ] | 9. Masa
10. Salida alarma A
1. Salida alarma B
12. Salida alarma C
13. Salida alarma D
14. Salida auxiliar carga+
15. Salida auxiliar carga+
16. Salida auxiliar carga-
17. Salida auxiliar carga-
18. Masa
19. Masa
20. Masa
carga+ 21. Entrada 1 Pulso rapido
. 22. Entrada 2 Pulso rapido
|PULSO LENTO |PULSO RAPIDO 23. Entrada 1 Pulso lento
Entrada 1-2 Entrada 1-2 24. Entrada 2 Pulso lento
25. Sin conexion

Lector de tarjeta de memoria externa

La ranura para la tarjeta SD externa se encuentra
dentro del compartimento de las pilas.

SQ2020/40 18108 Versione 17
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8. Accesorios

Grant Instruments suministra una amplia gama de accesorios para todos los registradores de
datos Squirrel. Entre otros se incluyen adaptadores como los que se muestran a continuacion que
permiten conectar de forma remota con el registrador de datos Squirrel. Todos son faciles de
instalar y conectar directamente al registrador a través de RS232. Para obtener mas informacién
o realizar pedidos, pédngase en contacto con Grant o el distribuidor local.

GSM

Inalambrico

N° articulo:
RS232 a conversor Ethernet que consta de caja de adaptador y de cable
de instalacién de médem. El software de configuracion de Ethernet permite
trabajar Unicamente con Windows 2000 y XP. SQ20A801
Kit de médem GSM con mddem, cable de conexidon de Squirrel, cable
de alimentacion y antena con cable de 3 m. También debe pedirse al proveedor
del servicio de red una tarjeta SIM habilitada para transmision de datos. SQ20A802
Adaptador inalambrico compuesto por un adaptador RS232 para conectar
el registrador al PC a velocidades de baudios de hasta 115K2 con un alcance
maximo de 200 metros en la banda de frecuencias de 2,4 GHz. El kit se
suministra con todos los cables de conexion.
Nota: las fuentes de alimentacion (MPU de 12 V) deben pedirse por separado. SQ20A803
18108 Versione 17 SQ2020/40
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N° articulo:
Opcion de memoria externa extraible
Tarjeta de memoria SD. MMC64

Paquetes de software para configuracion, transferencia y analisis de datos:
SquirrelView Plus
Ofrece analisis completo de datos, representacion grafica en linea, medicion en Excel

y exportacion a Excel. SQA200
Licencia multiusuario de SquirrelView Plus
Uso ilimitado de SquirrelView en una sola corporacion. SQA300

Certificados de calibracion de las series Squirrel 2020/40 (todas las gamas)

Nota: Los certificados de prueba y calibracion de Grant Instruments son analizables

de acuerdo con las normas nacionales.

SQ2020 CAL2020
SQ2040 CAL2040

Caja a prueba de intemperie
Robusta caja de plastico a prueba de intemperie. PEL4

Soporte para montaje en pared
Soporte de acero inoxidable para montaje en pared y mesa. WB6

Fuentes de alimentacién
CA de 100-240 V y 50/60 Hz suministrada con enchufes de alimentacion de

3 clavijas para el reino Unido, Europa y EE.UU. MPU 12V
Como MPU 12V pero con cable "flying lead" de 1 m. MPU 12VFL
Pila recargable (12 V, 6 Ah) SQ20RB12-6
Pila recargable (12 V, 15 Ah) SQ20RB12-15

Conector de interfaz de E/S digitales
Conector D de 25 vias tipo conexion soldada subminiatura con tapa para entradas
digitales, entradas de alarmas y pulsos. SB102

Derivaciones de corriente
Paquete de 4 resistores de precision para canales analdgicos de 4-20 mA CS202

Cables para conectar registradores de datos a PC/médem

Squirrel a puerto serie de PC LC71
Squirrel a puerto USB de PC LC77
Squirrel a médem LC73

Cable de alimentaciéon de CC de 12V
Conector de CC de 2,1 mm y soldado con cable de 1,8 m. LC76

Bloques de terminales
Bloques de terminales enchufables con sujecion de cables

3 vias 14174
4 vias 13975
6 vias 18097

Sondas de temperatura y humedad

Grant ofrece una gama de sondas de temperatura y humedad que pueden utilizarse con sus registra-

dores de datos y con otros sistemas de medicién compatibles. También se pueden encargar sondas a
medida o especificas. En caso de cualquier duda al respecto, consulte con nosotros.
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9. Especificaciones

ENTRADAS ANALOGICAS
Precision basica (5-45 °C): ........ccccooiiiiiiiiiii 1 (lecturas 0,05% + margen 0,025%)
Rechazo en modo COMUN: ............ooiiiiiiiiicc e 100 dB
Impedancia de entrada: .................coooiiiiiiii > 1 Mohm
Linealidad: ...............ccccceevnnne e 0,0015%
Rechazo de linea en modo serie: BTSRRI 50/60Hz 100 dB
Campo electromagnético y efecto de RF conducida: ..........................c. <1% ¥t
ENTRADAS DIGITALES
Tension de entrada cero...............ccccoveeiniienineeens De 0 a 0,5V (o entrada cortocircuitada)
Tension de entrada uno...............ccoooceeeiiineene De 2,7 a 5 V (o entrada de circuito abierto)

Proteccion de entrada .. se activara por debajo de aprox. -0,5 V y por encima de aprox. 6 V

CONVERSION ANALOGICA DIGITAL

LI <1 TSP OTPR Sigma-Delta
Resolucioén: ................ 24 bits
Velocidad de muestreo: ...............ccccooiiiiiiiiiiniiiiiene, Hasta 20/100 lecturas por segundo

Nota: El modo 100 Hz no esta disponible en los modelos 1F8

SALIDAS DE ALARMA .........ooiiiiieieeee e 4 colectores abiertos FET (18 V 0,1 A max.)
FUENTE ALIMENTACION
SENSORES...........ccceveviiiee. Tension regulada de 5 V de CC (50 mA) o de suministro (100 mA)
HORAY FECHA . ... Reloj integrado en 3 formatos
AJUSTE DE ESCALA
DE DATOS ................... Presenta las lecturas de datos en unidades de medicidn técnicas preferidas
MEMORIA
Interna: ... 128 Mb (hasta 14.400.000 lecturas)
Externa: ..o, Tarjeta de memoria MMC/SD extraible de hasta 1 Gb
RESOLUCION .........cooiiiiieeeeeececeeeee et n et enen s neneen Hasta 6 digitos
CONFIGURACION Y PROGRAMACION REGISTRADOR............ Software SquirrelView o SquirrelView Plus
COMUNICACION ........c.ooooimiieeeeeeeee e, USB 1.1y 2.0/ RS232/ Ethernet (no 1F8)
(0] o T4 1 41 (=1 4 o F- TP UPR SRR Wi-Fi
OpCioNes eXterNaS: ...........ccccvviiieeeiiiiiiiie e GSM, Ethernet e inalambrica

FUENTE DE ALIMENTACION
Interna: ....
Externa: ..........................

................................................................... 6 pilas AA alcalinas*
0-18 V de CC, polaridad inversa y protegida contra sobretension

+ Este efecto puede ser mas grande en 288kHz, reorientar los cables de la entrada o
agregar un grano de ferrita axial conveniente cerca del registrador si procede.

A * La temperatura maxima de funcionamiento de las pilas alcalinas AA suministradas es
de 50 °C
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CONSUMO DE POTENCIAa9V

ModO de SUSPENSION: ...........oooiiiiiiiiiiii e <600 pA
ReGISIIO: ... 40 - 120 mA
DIMENSIONES Y PESO
Registrador 2020
DiMeNSIONEeS: .......ooiiiiiiiiiie e An. 235 x F 175 x Al. 55 mm
Peso: ......cccccovveeinn. Aprox. 1,2 kg
Material de CarCasa: .............oooiiiiiiiiiiiii s ABS
Registrador 2040
DiMEeNSIONEeS: .......ooiiiiiiiiii e An. 235 x F 175 x Al. 92 mm
Peso: ..o Aprox. 1,5 kg
Material de CarCasa: .........c..ooiiiiiiiiiiiiie e eeas ABS
MODOS DE MEMORIA (sélo interna) ......................... Detener (Stop) al llenarse o sobrescribirse
PANTALLA Y TECLADO
LCD de 2 lineas x 20 caracteres
ENTORNO OPERATIVO ......oooiiiiiiiiiiiee ettt Desde -30 hasta +65 °C

Windows es una marca registrada de Microsoft Corporation en

Estados Unidos y otros paises.

Dada nuestra politica de mejora continua, las especificaciones estan sujetas a cambios sin previo

aviso.

Grant considera que toda la informacién declarada es correcta en el momento de su publicacion.
No se asume responsabilidad alguna por errores u omisiones.
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Notas personales:
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Declaration of Conformity

Manufacturer:-

Equipment Name/Type Number:-
Description of Equipment:-
Directives:-

Including Accessories:-

GRANT INSTRUMENTS (CAMBRIDGE) LTD,
Shepreth,

Cambridgeshire

SG8 6GB

2020/2040

Squirrel 2020/2040 Data Logger

EMC Directive 2004/108/EC

MPU 12V
LC71
LC77

Universal power supply
RS232 serial lead
USB lead

This product complies with the requirements of
with sensor leads up to 3m long, compliance m

the above Directive(s) when used
ay be affected by using longer leads.

Applied Standards:-

Harmonized Standards:-

EN 61326-1:2006

Electrical Equipment for measurement,
control and laboratory use - EMC
requirements

Part 1: General requirements

USA
This device complies with Part 15 of the F

CC rules. Operation is subject to the

following two conditions: (1) this device may not cause harmful interference, and
(2) this device must accept any interference received, including interference that

may cause undesired operation.
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